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GLOSSARY

CCVista (System:) An external system (http://ccvista.taiex.be/) serving as a source of files for translation and
for legal validation.

Celex A celex is a legal text which has a unique reference, and contains a legal text. The celexes
are available on EUR-Lex website: http://eur-lex.europa.eu/en/index.htm .
A celex is a set of celexLV (LV stands for Linguistic Version).

CELLAR + Metaconv | CELLAR is the new repository of the Publications Office. One of its modules is

Metaconv. Metaconv ensures the communication with legacy applications like CERES,
and converts the received files into the new format for CELLAR which is METS (XML +
semantic).

Ceres (System:)

Common Electronic Reception System. The major purpose of the CERES system is
receiving/distributing appropriately document series treated by the Publications Office
and further dissemination (publication) of the documents.

Check out Check-out function is used by the users of Plan-DD to perform modifications and
versioning (using check-in function) to files. When a document is checked-out then it is
stored locally in the user’s PC. The document is locked for other users. Nevertheless, the
rest of the users have read only access to a checked out document.

Check in Check-in functionality is used to add new version of files into Plan-DD performing

versioning. When the user finishes working with a document he can check it back in the
repository. The document is stored in the repository and becomes available again to all
the users.

Cleaned Document
LV files
(Deliverable:)

An output from OJ Format for a Document LV manuscript.

Contract Specific printer contract (part of printer)
Document A content of a Celex (file).
Document LV A Document LV contains the same legislative text as a Celex for the corresponding EU

official language.

Document metadata
(Deliverable:)

Document metadata as states, . etc. see a class model

EUR-Lex (System:)

EUR-Lex is a portal enabling access to law and publications. If a legal document has to
be published, for the Publication Office it means the legal document is accessible on the
EUR-Lex portal and printed version is available on the bookshop.

GC (Role:)

General Coordinator

Legal services (Role:)

The Legal services is an external role providing legal services. People from this role have
no access to the Plan-DD interface and they use CCVista

LV Linguistic Version

Manuscript A translator’s output placed on CCVista

(Deliverable:)

Model Model is a document in the Pilot language that will be used by the Proofreaders as a
reference.

OJ Format (System:) |OJ Format is an automatic checking tool, upon a predefined language rules updates

(cleans) input documents.

DEMED (System:)

A financial system, it is planned for tracking / validating invoices.
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PA (Role:) Production agent
Plan-DD (System:) A production system for DD (special edition of the secondary legislation)
PR (Role:) Proofreader

Printer (System:)

The printer is an external actor responsible for the creating the formex and pdf formats of
volumes. The printer is responsible for printing. The printer name is consisted of the
Contract/Lot/Supplier.

Procat (System:)

Procat is a reference source for law and publication metadata. Procat can be used to
identify celex metadata such as titles, chapters, pilot language content files, .

Supplier

Individual printing company (part of printer)

Task forms
(Component:)

Task forms component represents a default communication interface for proofreaders, It
has to enable seamless work support to offer a sorted task list with necessary information
to relevant group of proofreaders.

Volume proof PDF A PDF generated by a printer to validate a content and layout of a volume.
(Deliverable:)
Volumes A sorted set of Document LVs to be printed and published.

(Deliverable:)

Workflow engine
(Component:)

A workflow engine facilitates the flow of information, tasks, and events. Workflow
engines may also be referred to as a Workflow Orchestration Engines.
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1 Introduction

This document describes the PLAN-DD application from a user perspective. It helps users to familiarise themselves
with the PLAN-DD application and can also serve as a reference manual.

This User Manual explains the main concept and the functionalities of the PLAN-DD application. Users are
expected to have basic skills in using a web application.

This document has the following structure:

e Section 1: gives an introduction to main concepts of PLAN-DD.
e Section 2: describes common functionality available to all the PLAN-DD user roles.
e Section 3: describes the PLAN-DD functionality available to the Technical Support Agent role.

e Section 4: describes the PLAN-DD functionality available to the Production Agent and General
Coordinator role.

e Section 5: describes the PLAN-DD functionality available to the Proofreaders role.
e Section 6: describes the PLAN-DD dashboard functionality.

e Section 7: describes the PLAN-DD reports functionality.

1.1  User roles
The Users of the PLAN-DD system are:

e Technical Support Agent (TSA) — the person in charge to initialise the system and perform general
administration tasks.

e Production Agent (PA) — the person in charge of the follow up the production of the Document LVs,
creation and management of volumes, assignment of tasks to Proofreaders and characterisation.

e General Coordinator (GC) — the person in charge of the supervision of the production process and
assignment of tasks to Proofreaders.

e Proofreader (PR) — the person in charge of prior and control reading of documents LVs and proofreading
of volumes.

1.2 Plan-DD Repository Overview

The structure of the Plan-DD Repository consists of a Repository Root called Plan-DD, which contains a folder for
each Enlargement imported in the Plan-DD system. Under the Enlargement folder there are folders for each
Chapter for this Enlargement. Under each Chapter folder the following two folders exist:

s Documents

= Volumes

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 14 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

1.3 Documents

The “Documents” folder contains a folder for each Year (stated in the Document Identifier) of the Documents
which belong to the specific Chapter of the Enlargement. The Year folder contains a folder for each Document,,
which belongs to this Year. The name of the Document LV folder is the Document Identifier. The virtual
documents of a Document LV are located in the Document LV folder. The Document LV name is “Document
Identifier Language Code”. In particular, the structure of the path where the Document LV virtual documents are
located is defined below:

Plan-DD - Enlargement Name - Chapter Name > Documents = Year > Document Identifier >
Document Identifier-Language Code

The Virtual Document of a Document LV is a file that contains files and folders nested within it. The virtual
document is also called the parent document and the files within it are called descendants or children. The
Document LV Virtual document contains the folders Communication, Models and Proofs. It also contains a
document with the content of the specific Document LV.

1.4 Volume

The “Volumes” folder contains a folder for each Language Code, specified by the Enlargement. The Volume
virtual documents of a specific Language Code are located in the Language Code folder. In particular, the structure
of the path where the Volume virtual documents are located is defined below:

Plan-DD - Enlargement Name > Chapter Name - Volumes—> Language Code—> Volume Name

The repository structure is a representation of the Volumes for a specific Enlargement. In particular, the actor could
navigate through a list of Volumes for a specific Enlargement, sorted by the Language Code.

The Volume Virtual Document is a file that contains files and folders nested within it. The virtual document is also
called the parent document and the files within it are called descendants or children. The Volume virtual document
contains the folders Communication and Proofs.
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2 PLAN-DD common functionality
2.1 Connecting to the System: Log-in/Log-out

2.1.1 Loggingin

In order to log in:
1. In the Log-in Name field, type your user name.
2. In the Password ficld, type your password.

3. To have your local computer log you in automatically the next time you access Webtop, select the check
box Remember my credentials, If you select this, then you will not view a Log-in page the next time you
access Webtop. You will be logged in automatically.

The credentials are saved in a cookie on the computer from which you are accessing Webtop. If you delete
this cookie or log in from a different computer, you will have to type your credentials again.

4. Click Log-in

Plan-DD

Login Hame: ||

Password: |

Repository: | plandd_test | w

|:| Remember my credentials

[+] More Options

Figure 1: PLAN-DD log-in screen

If the provided Log-in Name and Password are correct, you will access the appropriate interface according to the
privileges of your account. If the provided Log-in Name and Password are incorrect, you will be prompted to re-
enter the abovementioned details.
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Plan-DD

Login Hame: |general_:o-c-r:linatc-r

Password: ||

Repository: | plandd_test »

|:| Remember my credentials

[+] More Options

We're sorry, authentication failed.

Figure 2: PLAN-DD log-in failed screen

Plan-DD

Login

: | general_coordinator
Mame

Pazzword: |

Password is blank. PFlease enter a valid

password.

Repository: | plandd_test w

|:| Remember my credentials

[+] More Options

Figure 3: PLAN-DD log-in failed screen — Blank password
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2.1.2 Logging out
At the top of the page, click Log-out.

Plan-DD

You have successfully logged off.
To log back in, click the button belows.

Login Again

Figure 4: PLAN-DD log-out screen

2.1.3 Timed out

After an extended idle time, you are logged out of the system automatically. To continue working, you have to
login again following the steps indicated above.

A “Timed out” message may appear.

2.2 Home page

Once you have logged in successfully, you are redirected to the PLAN-DD home page. The home page
differentiates according to the user.

Logged in as proofreader (hr), proofreader (is) | Logout  Help

Plan-DD e —

Top
Navigator

i# plandd_prod : Proof Reader (ED) Edit View Tools
- Inbox
'Q.“ Saved Searches
(a3 Subscriptions
ok Cabinets
Add Repository

Inbox (plandd_prod) | am available Show Al (Hide Attachments) v

Items per page: m

Subject | From ! Date Received | Due Date% Status ! Repository
. M Document Prior-reading for 3200400587-HR dmadmin 07/05/2011 15:16 Dormant plandd_prod £
- M Document Prior-reading for 32004D0579-HR dmadmin 07/065/2011 15:16 Cormant plandd_prod
Left Navigator : B Document Frior-reading for 3200400564-HR dmadmin 07/05/2011 15:16 Dormant plandd_prod
. M Document Prior-reading for 3200400542-HR dmadmin 07/05/2011 15:16 Dormant plandd_prod
. H Document Prior-reading for 3200400544-HR dmadmin 07/05/2011 15:16 Dormant plandd_prod
H M Document Prior-reading for 32003L0083-15 dmadmin O7/05/2011 15:14 Dormant plandd_prod

M Document Prior-reading for 32003L0084-15 dmadmin

{05/2011 15:14 Dormant plandd_prod

Fl pocument Prior-reading for 320

LO0BO-I5 dmadmin Dormant plandd_prod

. M Document Prior-reading for 32003

}81-15 dmadmin 070! . mant plandd_prod
Main Page

: H Document Prior-reading for 32003L0082-15 dmadmin 070! mant plandd_prod

Figure 5: Home page — Inbox
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The PLAN-DD home page is composed of:
e Top navigation,
e Left navigation, and

e Main page.

2.2.1 Top navigator
This area of the interface is static and contains the following navigation tools:
e Search field: performs an instant document search when you enter a document number or content search

phrase and then click on the “Start Search” button . By clicking on the down arrow next to the search
field, you can also access the Advanced Search form.

e Help: launches the online help for the Webtop page, currently displayed in the workspace.

e Logout: closes all open Webtop files and clears your personal security information from the local cache.
This prevents unauthorised access by the next person using the browser.

2.2.2  Left navigator
The left navigator may contain the following links according to the user profile:
e Inbox: displays the tasks and notifications sent to you
e Saved Searches: displays all the saved searched of the logged in user
e Subscriptions: displays the files and folders that you have added in order to have quick access
e Administration: displays and give access to administrative tasks according to your profile

e Dashboards: are forms which can be used in order to generate reports containing documents, volumes, and
tasks or for order tracking purposes according to selected criteria. Dashboards are available under
Dashboards label on the left navigation tree.

e Reports: are forms which can be used in order to view statistics about documents, volumes, pages sent to
Printers or produced pages per task according to selected criteria.

e Cabinets: displays the highest level of organisation in a repository. Cabinets hold folders and files.

Your Inbox contains the tasks and notifications sent to you. Tasks are electronic assignments sent to you as part of
a workflow. When you receive a task, you choose whether to accept it or reject it. When you complete a task, you
forward it. The workflow notifies the next user in sequence. Tasks can include attached files. Notifications are
messages letting you know when a specific action has occurred on a document.

When a search with specific search criteria is used, you can perform is only once and the save it as a Saved Search.
When you access Saved Searches, this search will be displayed and can be used at any time returning the updated
search results.

To have quick access to a cabinet, folder, or file, you can subscribe to it. The item then appears in your
Subscriptions. Instead of navigating through the repository to find the item, you can access it quickly through
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Subscriptions. When you open or view an item through Subscriptions, the item is retrieved from its original
repository location.

You can create reports by using the search criteria under the Dashboards. You can use either Documents
Dashboard or Task Workload Dashboard in order to create your reports and then select specific files or folders

and select specific actions to perform.

2.2.3 Main page — Work area

The main page is the working area where the results of actions are presented and the user can work on the

documents. On the main page you can access a task or a notification that has arrived in your Inbox.

When accessing a task (see figure below), you can have the following options according to the user profile, the task

type and the status of the task (dormant or accepted):

e Accept the task and work on it. The task also disappears from other users’ inbox.

¢ Finish the task (the task disappears from your inbox)

e Reject the task and automatically delete it from your Inbox

e Close the task without accepting it (the task remains in your inbox)
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File Edit

Metadata | Document Manager

Control-reading for document 31988L0667-HR

Description Please, execute control-reading to the Document LV
Document Reference  31988L06&6T

Language HR

Chapter 13 Industrial policy and internal market

Publication Reference 1983L382p0046

Publication Date

Humber of pages 3

Volume name

CCVista Status Finalised

Council Directive 88/667FEEC of 21 December 1988 amending for the

Title EN
fourth time Directive 76/768/EEC on the approximation of ...

Comments

iy
A Prior-reading has not been performed

Attachments
Hame Version Size Date Modified
@ 31988L0667-HR.doc 1.0,CURRENT,Finalised 52 KB /0772011 12:08

Figure 6: Task info

2.3 Repository

The repository is a virtual storehouse for the content that a user works on and shares with other users. Each
repository provides security, tools, and processes for sharing content among many users.

The structure of the PLAN-DD Repository consists of a Repository Root which contains the Enlargements that in
turn contains the following cabinets:

e Enlargement

o Chapter
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*  Documents Directory
e Year
o Document
= Document LV
e Communication
e Models
*  Volumes Directory
e Language
o Volume
=  Communication

=  Proofs

The next figures provide a pictorial representation of the Repository as it will be seen by a PLAN-DD user with the
appropriate permissions.
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plandd_prod : Production Agent (ED)
o Inbox

‘i Saved Searches

G Subscripticns

|>

gﬁutamatic Update Enlargement

Closed Enlargement
Enlargment 2012 <::\‘ Enlargement Name

01 General, financial and institutional ﬂatter5<::< Chapter

Documents
Volumes <::“ Documents and Volumes directories
02 Customs Union and free movement of

03 03.50.30 Animal health and zootechnics

05 06.20.20.10 Safety at work

06 06 Right of establishment and freedom to pros
07 07.10.30 User tariffs

08 08 Competition policy

09 09 Taxation

10 10 Econemic and monetary policy and free mo
11 11 External relations

12 12.10.20 Ratignal utilisaticn and conservation
13 13.30.14 Foodstuffs

14 14 Regional policy and coordination of structu
15 15.10.30.30 Waste management and clean tec
16 16 Science, information, education and culbur
17 17 Law relating to undertakings

18 18 Commeon, Forsign and Security Policy

19 19 Area of freedom, security and justice

20 20¢ People’s Europe

21 21 Temporary chapter for finilization

—% J'_-'.arrliall u pdatelE nlargement

| &

[
|

Figure 7: Structure of PLAN-DD Repository
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1975
= 1974

Document Name

Communication.doc

R 31976R0142-HR <::‘1
Ii: Communication

Document LV

Figure 8: Structure of PLAN-DD Repository — Document Structure

Ehf) Volume-03-001-HR
': Communication
Proofs

Figure 9: Structure of PLAN-DD Repository — Volume Structure

In order to browse the Repository:

1. Click the tab corresponding to the node you want to navigate. For example, to navigate the Cabinets node,

click the Cabinets tab.

2. The next directory level opens. To open a location in the directory (such as a folder), click the location.
You can continue “drilling down” through the directory structure by continuing to click locations until you

find the item you are looking for.

3. To go back to a higher level in the directory structure, do one of the following:

¢ In the navigation path at the top of the page, click the directory location you want to go to.

To go to the top level of a node, click the node.

2.4 Document manager

In order to work on or manipulate a document, you have to access the Document Manager. The Document Manager

can be accessed by clicking on the Document Identifier and is presented in the following figure:
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B, 31988L0667-HR
W] 31988L0667-HR.doc

plandd_test / Plan-DD / Enlargement 2012 / 13 Industrial policy and internal market / Documents / 198 B8LOG6T / 31988L066T-HR
Document 31988L0667-HR

Document ldentifier

Language

Chapter

Publication Reference
Publication date
Number of pages
Volume Name
CCVista Status

Acquis list status

Procat update date

31988L0667 Started Inprogress Completed
HR Procat @
13 Industrial policy and internal market 0J-Format @
1988L382p0046 oo

Control-reading @

Property Cleaning
&

EUR-Lex

Cellar
Finalised

State Legend : @ Valid @ Disabled @ |nvalid
Included
04-Aug-2011

Council Directive 88/667/EEC of 21
December 1988 amending for the fourth time

Title EN
i Directive 76/768/EEC on the approximation
of ...
Mot Availzkle Prior-Reading Legal Finalization Ready far Printer Puhblizhed

Name

Version Modifier Modified Full Content_size Format

Iﬂ._] 31988L0667-HR.doc CURRENT,1.0,Finalised dmadmin 01/07/2011 12:08 52 KB MEWord 4.x, ...

Figure 10: Document Manager

On the left navigator you can access the subfolders of the document and find all the attached files related to it or
you can use the main page to navigate on the document. You can also click on the Metadata button to access the
metadata of the document or the Audit Document button to view the audit with all the important actions that have
been performed on the specific document.

In order to access the entire tree of documents and volumes, including the Inbox, select the Display link on the left
navigator and then the Show all link, as shown in the following figure.

Expand selection
Collapse selection

Showe all

In order to update the Document Manager, please click on the Document name on top of the left navigation tree.
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2.5 Volume manager

In order to work on or manipulate a volume, you have to access the Volume Manager. The Volume Manager can be
accessed by clicking on the Volume Identifier and is presented in the following figure:

Display [5ave] Fie Edit View Tools Administration
., Volume-01-006-HR

plandd_test / Plan-DD / Enlargement 2012 / 01 General, financial and institutional matters / Volumes / HR / Volume-01-006-HR
Volume-01-006-HR

Volume Audit
Volume Name Volume-01-006-HR Started Inprogress Completed
Chapter 01 General, financial and institutional matters Legal Services ]
Language HR Budget Request @
5 X ®
Assignee Panos Kavalagios (ED) Publication Request

Proof-readin
Catalogue Number F-AZ-13-057-HR-C e

— CERES
Publication date 17-0ct-2011

Ready for Press
Contract Supplier 10288/ Euroscript

Close Volume
Total pages [

Characterisation
DEMED Status WALID

Publication Confirmation

DEMED Progress COMPLETE
SICOF

State Legend : @ Valid @ Disabled @ Invalid

Created Frepare Legal Validation Legally Validated Ordered Proof-Reading Ready for Publication Closed m Characterised
Name Version Modifier Modified Full Content_size Format .
Ll Ready For Press CURRENT,1.0' General Coordinator (ED) 187102011 14:14 1KB -
hd | R | >

Figure 11: Volume Manager

On the left navigator you can access the subfolders of the Volume and find all the attached files related to it or you
can use the main page to navigate on the Volume. You can also click on the Metadata button to access the
metadata of the volume or the Audit Document button to view the audit with all the important actions that have
been performed on the specific volume.

From the Volume Manager, users have also the option to open the Print Production File (PPF) from where they
can view or manage the volume depending on their user role.
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Print Production File :
Volume Functions Document Functions Ready for Press

Volume-01-002-HR Mov 14, 2011 10288/Euroscript Total Pages: 2 Status: Prepare Demed Status: DATA_CHANGE Language

TOC Pﬁges: Document Titles: @ show O Hide

D Document Publication
Identifier Reference

Status Included/Excluded — End Comments
Fage rage

Decision creating the "Official Journal of the Europsan Communities’

. TR Prigr- ~
O @ 3is5a01008001) 1958P017p0390 Reacing Included 1 [

63/32FEEC: Council Decision of 18 December 1962 on the determination of the appointing autherity for the Audit Board

. imn Mot ~
0 @ 3198300032 1963P012p0139 mtanie Included 2 z 1|

Figure 12: Print Production File

In the PPF form, you can select the language from the corresponding drop down list and select the language in
which the titles of the Documents will be displayed.

Moreover, from the Document Titles radio buttons “Show” and “Hide”, you can select if the titles of the documents
will be displayed or not.

The PPF can be also exported to MS Excel file in CSV format by pressing the button. The
titles of the Documents will be also exported depending of the previous selection of showing or hiding them.

In order to access the entire tree of documents and volumes, including the Inbox, select the Display link on the left
navigator and then the Show all link, as shown in the following figure.

Expand selection
Collapse selection

Show all
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In order to update the Volume Manager, please click on the Volume name on top of the left navigation tree.

2.6  Workflow availability

There are two types of user availability to receive new tasks:
e Jam available
e [ am currently set to unavailable

You can determine whether you are available to receive workflow tasks. If you make yourself unavailable to
receive tasks, you must designate another user to receive your tasks for you.

The top of your Inbox displays your availability. "I am available" indicates you are available to receive tasks; "I am
currently set to unavailable" indicates you are not available to receive tasks and that another user is designated to
receive the tasks sent to you. This setting is useful, for example, if you will be out of the office for an extended
period.

To change your availability to Unavailable:
1. Access your Inbox.
Click your availability status: I’m available.
On the Workflow Availability form below, select the check box I am currently unavailable.

Click on edit link to select a user to direct your tasks.

wok »

Double click on a group to view the list of users or select Show Users from the drop down list on the right
top, or use the Starts with field on the top to find a specific user.

6. Click OK to change your availability and return to your Inbox.
To change your availability to Available:
1. Access your Inbox.
2. Click your availability status: I am currently unavailable.
3. On the Workflow Availability form below, deselect the check box I am currently unavailable.
4

Click OK to change your availability and return to your Inbox.

All the users that receive tasks have the option to change their availability. When a user chooses to designate
another user to receive their tasks, he/she needs to check the availability of other users (for production agent, only
other production agent can be designated and general coordinator by default, for proofreaders, other proofreaders in
the team can be designated).
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Workflow Availability :

Waorkflow Tasks

I am currently unavailable. Please direct my tasks to:

[not selected] edit

Figure 13: Workflow availability

2.7 Subscribe

To have quick access to a cabinet, folder, or file, you can subscribe to the cabinet, folder, or file. The item then
appears in your Subscriptions. Instead of navigating through the Repository to find the item, you can access it
quickly through Subscriptions. When you open or view an item through Subscriptions, the item is retrieved from
its original repository location.

In order to subscribe to a document or folder:
1. Navigate to its parent by using the left navigation
2. Select the document or folder and right click on it.

3. Select Subscribe from the right click menu.
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Figure 14: Subscribe

In order to unsubscribe from a document:

1. Click on Subscriptions on the Left navigator or navigate to find the document or folder you want to
unsubscribe.

2. Select the document or folder and right click on it.

3. Select Unsubscribe from the right click menu.

i
i
v

| Hame Full Content_size Format| Modified

L (22 el Fa sl Fra ¥ WENNN.] 4 1rn P W X1 o] 11 10:14

Edit
L0 3200 Open (Read Cnly) 011 10:53
Check Out
Unsubscribe
Subscribe Others
Email &z Link

Add Relationship
Quickfiow

Export To CSV

Figure 15: Unsubscribe

You can also subscribe or unsubscribe other users by using the corresponding right click menu option and selecting
the groups or users that you want to subscribe.

2.8 Search

2.8.1 Quick search
In order to perform a quick search:

1. In the Search field at the top of the page, type the text that you want to search for and click Start Search
button.
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2.8.2 Advanced search

In order to perform a search with advanced options:

1. Click on the down arrow E next to the Quick Search field and then select the Advanced option.

] Advanced shift+

Document Identifier :

Publication Reference :

Language :
Chapter :
Subchapter :

Institutions :

Statws :

CC Vista Status :

From Publication Date :

To Publication Date :

Volume Number :

Prioreading : ves () Mo () Both (&)

Figure 16: Advanced search form

3. Select the criteria that you want by using the corresponding free text fields and drop down lists.

4. Click on the Search button in order to perform the search based on the selected criteria.

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 31 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

2.8.3  Search results
While the search runs, Webtop displays the first page of results.

1. Double click on Name to open a specific upload or folder.

Search Results
1000+ Results for “319" in plandd_prod - 11/05/2011 12:35

€ €D Page of 2+ 03 Items per page:
=9 Name Ranking| Modified Source |EEM
3199901074 72 12/04/2011 16:53 plandd_prod A
L 31999m1074-HR 73 03/05/2011 18:02 plandd_prod
31999Y0317(01)  72% 12/04/2011 16:53 plandd_prod
L 31999v0317(01)-HR 71% 12/04/2011 16:53 plandd_prod
3199410080 1% 12/04/2011 16:48 plandd_prod
L )31994L0080-HR 70 12/04/2011 16:48 plandd_prod 1
31996L0030 703 12/04/2011 16:48 plandd prod
[ )31996L0030-HR 7O 02/05/2011 19:10 plandd_prod
31998R2679 69 12/04/2011 16:48 plandd prod
| 1/31998R2879-HR 7O 05/05/2011 15:34 plandd_prod
3199900132 69 12/04/2011 16:48 plandd prod
L )31999D0132-HR 69 20/04/2011 23:40 plandd_prod
31987R2658 69 13/04/2011 18:55 plandd prod
| 1/31987A2858-HR  #9 04/05/2011 15:24 plandd_prod
31989R3528 68 12/04/2011 16:46 plandd_prod
| 1/3198903528-HR B 18/04/2011 13:13 plandd_prod

Figure 17: Quick search results

When you perform a quick search, the Search results page is displayed, listing all of the objects (documents and
folders) that meet the criteria of that search. The Search Results screen provides you with the opportunity to
Restart, Edit and Save the Search by clicking on the corresponding links at the top of the Search results. The
displayed information includes Document Name, Ranking, Modified date and Source.

e To reorder a search result list based on a column, click the column heading. Click the column heading
twice to change the sort order from ascending to descending.

e To select which columns will appear for a particular view, click on the Column preference icon =¥

e To scroll forward through the list of results, click the right arrow E To scroll backward, click the left
arrow Al.

e To set the number of documents the Search results page lists, select from the Items per page drop-down
list one of the following numbers: 10, 50 or 100.

To select or deselect the highlighted text (text that matches the search criteria), click on the Highlight icon .
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3  Technical Support Service

3.1 Manage Enlargements

3.1.1 Create New Enlargement

In order to create a new Enlargement:

1. Select Administration 2 Enlargement 2 New

Administration
Configuration Parameters
Acguis List

Enlargements

Languages

Chapters

Sub-chapters

Institutions

Contracts

Suppliers

Printers

Workflow

b . A . . . . A . . A

2. In the displayed form fill in at least the mandatory fields which are indicated by an asterisk (*). The Name
of the Enlargement and the Accession Date are the mandatory fields that have to be filled. The Status of
the Enlargement by default is Active and the Automatic Update is set to No. You can also enter the
Catalogue Prefix and Suffix to the corresponding fields.
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Enlargements :

Hame

Accession Date
Status

Automatic Update
Catalogus Prefix
Catalogus Suffix

Default due date of reading tasks

H |Enlargr‘1c—nt 22
[ormoe o8
: @ Active O Closed
O ves @ Mo

: [Pz

.|_r|
HIEs

e

Figure 18: Create a new Enlargement

3. Click on OK button to confirm the creation of the Enlargement

The created Enlargement will be displayed in the list of Enlargements

Starts With [=]x
Hame Accession Date Status Automatic Update Catalogue Prefix Catalogue
Suffix
Automatic Update Enlargement  26/04/11 Active es Fix-47- -C
Closed Enlargement Closed Mo
Enlargment 2012 m/o1/12 Active fes FX-AZ- -C
Manual update Enlargemsnt Active No
Figure 19: List of Enlargements
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3.1.2 Edit Enlargement

In order to edit an existing Enlargement:
1. Navigate to the list of Enlargements under Administration from the left navigation
2. Select the Enlargement you want to edit

3. Right click and select Edit or select Administration - Enlargements > Edit

Enlargment 2012 Edit Active

Wanual update Enlal pelete Active

Figure 20: Edit Enlargement
4. Edit the fields that you wish

Click OK in order to close the form and save the modifications

3.1.3 Delete Enlargement

In order to delete an Enlargement:
1. Navigate to the list of Enlargements under Administration from the left navigation
2. Select the Enlargement that you want to delete

3. Right click and select Delete or select Administration = Enlargements - Delete

Enlargment 2012 [ 45 Active

Manual update En| Delete Active

Figure 21: Delete Enlargement

4. The profile of the Enlargement will be displayed in order to view the details
5. Click OK in order to confirm the deletion

In case the Enlargement has associated data, the following message will be displayed informing the user that the
Enlargement can not be deleted.

The enlargement cannot be deleted. There are data (Acquis List, Language, Document, Chapter, Subchapter
or Printer) associated to it.

3.2 Manage Languages

3.2.1 Create New Language
In order to create a new Language:

1. Select Administration - Languages - New
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Admimistration
Configuration Parameters
Acquis List

Enlargements

Languages

v v v v

2. In the displayed form fill in at least the mandatory fields which are indicated by an asterisk (*). The
Language code and the Language name are the mandatory fields that have to be filled. The Country
code (CCVista), the Language (OJ-Format), the Enlargement which is selected from the drop down list
containing all the available Enlargements, the ISSN (Print) number and the ISSN (Online) numbers are
also available fields that can be filled for the description of the new created Language.

Languages : MHew

Language cnde:|HR

Language name : | Croatian

Country code (CCVista) : |HR

Language (0OJ-Format) : |HR

Enlargement : | Enlargment 2012

ISSN (Print) : |1245-567

ISSN (Online) : |2313

Figure 22: Create a new Language

3. Click on Save button to confirm the creation of the new Language

The created Language will be displayed in the list of Languages

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 36 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN DD USER MANUAL Reference Number / Version:
D.PDD.UMA-2.2.0/0.05
Starts With | [ x|
Language code Language name Country code Language (0J-Format) Enlargement I55H (PFrint) IS5M (Online)
(CCVista)
HR Croatian HR Enlargment 2012 1245-567 2313
Automatic Update
EE European 15 Enlargement 1234-5678 9875-4321
15 |celandic 15 Enlargment 2012 1234-567

Figure 23: List of Languages

3.2.2 Edit Language

In order to edit an existing Language:
1. Navigate to the list of Languages under Administration from the left navigation
2. Select the Language you want to edit
3. Right click and select Edit or select Administration = Languages 2 Edit

Pt ¥ IILa)

Croatian Edit

Celete
Figure 24: Edit Language
4. Edit the fields that you wish

5. Click Save in order to close the form and save the modifications

3.2.3 Delete Language

In order to delete a Language:
1. Navigate to the list of Languages under Administration from the left navigation
2. Select the Language that you want to delete
3. Right click and select Delete or select Administration - Languages > Delete

Croatian Edit
Delete

Figure 25: Delete Language

4. The profile of the Language will be displayed in order to view the details
5. Click Delete in order to confirm the deletion

In case the Language is related to a Document LV, the following message will be displayed informing the user that
the Language can not be deleted.

The language can't be deleted because it is related to Document LV
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3.3 Manage Institutions

3.3.1 Create New Institution
In order to create a new Institution:

1. Select Administration = Institutions = New

Administration

Configuration Parameters
Acquis List
Enlargements

Languages
Chapters
Sub-chapters
Institutions

2. In the displayed form fill in the mandatory fields Name of the Institution and the Abbreviation
(DEMED). The Status by default is set to Active.
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Institutions : New

Mame : [COUNCIL

Abbreviation (DEMED) : |CON

Status: @ Active O Inactive

Figure 26: Create a new Institution

3. Click on OK button to confirm the creation of the new Institution

The created Institution will be displayed in the list of Institutions

Show items [REREEE

starts With [=[x
Hame Abbreviation (DEMED) Status
COUNCIL CON Tes

Figure 27: List of Institutions

3.3.2  Edit Institution
In order to edit an existing Institution:

1. Navigate to the list of Institutions under Administration from the left navigation
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2. Select the Institution you want to edit
3. Right click and select Edit or select Administration = Institutions 2> Edit

Hame
COUMCIL Edit
Delete

Figure 28: Edit Institution

4. Edit the fields that you wish

Click OK in order to close the form and save the modifications

3.3.3 Delete Institution

In order to delete an Institution:
1. Navigate to the list of Institutions under Administration from the left navigation
2. Select the Institution that you want to delete

3. Right click and select Delete or select Administration = Institutions - Delete

Starts With
Hame

Delete

Figure 29: Delete Institution

4. The profile of the Institution will be displayed in order to view the details
Click OK in order to confirm the deletion

In case the Institution has Chapters related, the following message will be displayed informing the user that the
Institution can not be deleted.

There are some Chapters related for this Institution: can't be deleted

3.4 Manage Chapters

3.4.1 Create New Chapter
In order to create a new Chapter:

1. Select Administration > Chapters > New
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Administration

Configuration Parameters
Acquis List

Enlargements

Languages

Chapters

v v vy v v

2. In the displayed form fill in the mandatory fields Chapter Name, the Chapter Number and select the
Enlargement from the drop down list. You can also select the corresponding Institution from the
Available Institutions list and add them in the Selected Institutions by using the right and left arrows.

Chapters Management : New

Chapter Mame : |11 External relations

Chapter Mumber : |3

Enlargement : | Enlargment 2012

Available Institutions Filter by Institutions

COUNCIL

Institution : %

Figure 30: Create a new Chapter

3. Click on Save button to confirm the creation of the new Chapter

The created Chapter will be displayed in the list of Chapters
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Starts With
Chapter Hame Chapter Humber Institution Enlargement
07 07.10.30 User tariffs a Automatic Update Enlargement
06 06 Right of establishment and freedom
to provide services

13 13.30.14 Foodstuffs

Automatic Update Enlargement
Automatic Update Enlargement

11 11 External relations Automatic Update Enlargement

=T =T =T =

03 03.50.30 Animal health and zootechnics Automatic Update Enlargement

Figure 31: List of Chapters

3.4.2  Edit Chapter

In order to edit an existing Chapter:
1. Navigate to the list of Chapters under Administration from the left navigation
2. Select the Chapter you want to edit
3. Right click and select Edit or select Administration = Chapters 2> Edit

Chapter Hame Chapter Humber
07 07.10.30 User tariff 0

Edit
06 06 Right of establizh| Delete

-

Figure 32: Edit Chapter
4. Edit the fields that you wish

5. Click Save in order to close the form and save the modifications

3.4.3 Delete Chapter

In order to delete a Chapter:
1. Navigate to the list of Chapters under Administration from the left navigation
2. Select the Chapter that you want to delete
3. Right click and select Delete or select Administration > Chapters = Delete

11 11 External relatic Edit L]

03 03.50.30 Animal he| Delete .

Figure 33: Delete Chapter
4. The profile of the Chapter will be displayed in order to view the details
5. Click OK in order to confirm the deletion

In case the Chapter is related to a Volume, the following message will be displayed informing the user that the
Chapter can not be deleted.

The chapter can't be deleted because it is related to some volume
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3.5 Manage Sub-chapters

3.5.1 Create New Sub-chapter
In order to create a new Sub-chapter:

1. Select Administration = Sub-chapters 2 New

Admimstration
Configuration Parameters
Acquis List

Enlargements

Languages

Chapters

Sub-chapters

2. In the displayed form fill in the mandatory fields. Select the Enlargement from the drop down list and then
the Chapter from the drop down list which will be updated according to the selected Enlargement. You
have also to enter the Sub-chapter Name and the Sub-chapter Number.

Sub-chapter Form : New

Enlargement : | Enlargement 2012 & |

Chapter : | 01 General, financial and institutional matters

Sub-chapter Hame:|5tati5t1’:5 #

Sub-chapter Mumber @ |01.07 #
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Figure 34: Create a new Sub-chapter

3. Click on Save button to confirm the creation of the new Sub-chapter

The created Sub-chapter will be displayed in the list of Sub-chapters

Starts With | ™ X
Sub-chapter Chapter Enlargement
01.07 Statistics 1 General, financial and institutional matters Enlargment 2012
01.10 Principles, objectives and tasks of the

Figure 35: List of Sub-chapters

3.5.2  Edit Sub-chapter

In order to edit an existing Sub-chapter:
1. Navigate to the list of Sub-chapters under Administration from the left navigation
2. Select the Sub-chapter you want to edit
3. Right click and select Edit or select Administration = Sub-chapters - Edit

Sub-chapter
01.07 5tatistics Edit

01.10 Principles, obje{ Delete he

Figure 36: Edit Sub-chapter

4. Edit the fields that you wish

5. Click Save in order to close the form and save the modifications

3.5.3 Delete Sub-chapter

In order to delete a Sub-chapter:
1. Navigate to the list of Sub-chapters under Administration from the left navigation
2. Select the Sub-chapter that you want to delete
3. Right click and select Delete or select Administration = Sub-chapters - Delete

Starts With
Sub-chapter
01.07 Statistics Edit
01.10 Principles, obje| Delete he

Figure 37: Delete Sub-chapter

4. The profile of the Sub-chapter will be displayed in order to view the details
5. Click OK in order to confirm the deletion
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In case the Sub-chapter is related to a Document LV, the following message will be displayed informing the user
that the Sub-chapter can not be deleted.

Sub-chapter cannot be deleted. It is already related to a Document LV

3.6 Manage Suppliers

3.6.1 Create New Suppliers

In order to create a new Supplier:

1. Select Administration > Suppliers > New

Administration

Configuration Parameters
Acquis List

Enlargements

Languages

Chapters

Sub-chapters

Institutions

Contracts

Suppliers

e . . . . . .

2. In the displayed form fill in the mandatory fields. Enter the Suppliers Name and the Abbreviation
(Ceres) in the appropriate fields. The Status by default is set to Active.
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Suppliers Management : New

Supplier Mame : |Eur05:ri|}t |’

Abbreviation (Ceres) : |EU

Active Status 1 (8 active O Inactive

Figure 38: Create a new Supplier

3. Click on Save button to confirm the creation of the new Supplier

The created Supplier will be displayed in the list of Suppliers

Starts With || x

Supplier Hame Abbreviaticn (Ceres)

Eurgscript EU

Figure 39: List of Suppliers

3.6.2 Edit Suppliers

In order to edit an existing Supplier:

Cance

Active Status
Active

1. Navigate to the list of Suppliers under Administration from the left navigation

2. Select the Suppliers you want to edit

3. Right click and select Edit or select Administration = Suppliers > Edit
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Supplier Hame

Euroscript Edit

Figure 40: Edit Supplier
Edit the fields that you wish

Click Save in order to close the form and save the modifications

Delete Supplier

In order to delete a Supplier:

1.
2.
3.

4.
5.

In case the Supplier is related to a Printer, the following message will be displayed informing the user that the

Navigate to the list of Suppliers under Administration from the left navigation
Select the Supplier that you want to delete
Right click and select Delete or select Administration > Suppliers > Delete

Starts With || x
Supplier Hame
Euroscript Edit
Delete

Figure 41: Delete Supplier

The profile of the Supplier will be displayed in order to view the details
Click OK in order to confirm the deletion

Supplier can not be deleted.

Selected supplier cannot be deleted. It is associated to a printer record.

3.7 Manage Contracts

3.7.1

Create New Contract

In order to create a new Contract:

L.

Select Administration 2 Contracts 2 New

Administration
Configuration Parameters
Acquis List

Erlargements

Languages

Chapters

Sub-chapters

Institutions

Confracts

e s
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2. In the displayed form fill in the mandatory fields. Enter the Contract Number, the Year and the Number
of Lots in the appropriate fields. The Status by default is set to Active. You can also add optionally a
Description of the Contract.

Contracts Management : New

Contract Number @ [10202 #
ear : | 2008 #
Mumber of Lots : [0 #
Active Status : @ Active O Inactive
Description :

Figure 42: Create a new Contract

3. Click on Save button to confirm the creation of the new Supplier

The created Contract will be displayed in the list of Contracts

Starts With || x
Supplier Hame Abbreviation (Ceres) Active Status
Eurascript EL Active
Figure 43: List of Contracts
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3.7.2  Edit Contracts

In order to edit an existing Contract:
1. Navigate to the list of Contracts under Administration from the left navigation
2. Select the Contract you want to edit

3. Right click and select Edit or select Administration - Contracts > Edit

Cantract Humber Year

10202 Edit 2008
Delete

Figure 44: Edit Contract

4. Edit the fields that you wish

5. Click Save in order to close the form and save the modifications

3.7.3  Delete Contract

In order to delete a Contract:
1. Navigate to the list of Contracts under Administration from the left navigation
2. Select the Contract that you want to delete
3. Right click and select Delete or select Administration > Contracts > Delete

Starts With
Cantract Humber Year
10202 it 2008
Delete

Figure 45: Delete Contract
4. The profile of the Contract will be displayed in order to view the details
5. Click OK in order to confirm the deletion

In case the Contract is related to a Printer, the following message will be displayed informing the user that the
Contract can not be deleted.

Contract cannot be deleted. It is associated to a printer record

3.8 Manage Printers

3.8.1 Create New Printer

In order to create a new Printer:
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1. Select Administration = Printers 2 New

Administration
Configuration Parameters
Acquis List
Enlargements
Languages
Chapters
Sub-chapters
Institutions
Confracts
Suppliers
Printers
Worlflow

L R . . . . . . . .

2. In the displayed form fill in the mandatory fields. Select the Contract from the drop down list, the
Supplier, the Enlargement and finally enter the Cascade Order of the Printer. In case there are Lots
under the selected Contract, a drop down list to select specific Lot will be also available.

Printers Management : New

Contract : *

Enlargement : | Enlargment 2012 v|

Cascade Order: |3 |
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Figure 46: Create a new Printer

3. Click on Save button to confirm the creation of the new Supplier

The created Printer will be displayed in the list of Printers

Starts With
Contract Lot Supplier Enlargement
10202 Euroscript Enlargment 2012

Figure 47: List of Printers

3.8.2  Edit Printer

In order to edit an existing Printer:
1. Navigate to the list of Printers under Administration from the left navigation
2. Select the Printer you want to edit

3. Right click and select Edit or select Administration = Printers 2> Edit

Starts With
Contract Lot
10202 | Edit

Figure 48: Edit Printer

4. Edit the fields that you wish

5. Click Save in order to close the form and save the modifications

3.8.3 Delete Printer

In order to delete a Printer:
1. Navigate to the list of Printers under Administration from the left navigation
2. Select the Printer that you want to delete
3. Right click and select Delete or select Administration = Printers - Delete

Starts With |
Cantract Lot
10202 Edit

Delete
Figure 49: Delete Printer

4. The profile of the Printer will be displayed in order to view the details
5. Click OK in order to confirm the deletion

Cascade Order
3

In case the Printer is related to a Volume, the following message will be displayed informing the user that the

Printer can not be deleted.
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Printer cannot be deleted. It is already related to the volume.

3.9 Application and Adapter Configuration

3.9.1 Application Configuration Parameters
In order to set or edit the Application Configuration Parameters:

1. Select Administration > Configuration Parameters - Application

Administration
Configuration Parameters ¥ Application
Arcquis List ¥ Adapters

You can also access the Application Configuration Parameters form by selecting the Configuration
Parameters under Administration from the left navigation and then selecting the Application link.

2. In the displayed form you can fill or edit the following parameters:
e Proxy Server Configuration
e Proxy Server Authentication
e Mail Server Configuration
e Legal Services
e Application Temporary Directory

e Volume Configuration
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Proxy Server Configuration

Proxy Server

Port

squid-test.eurodyn.com

800

Proxy Server Authentication

Username

Password

asmo

Web Server Configuration

*Web Server

*Port

plandd-db.eurodyn.com

Application Server Configuration

*Application Server

*Port

plandd-test.eurodyn.com

7001

Mail Server Configuration

*E-mail Name
*E-mail Address
*Mail Server
*Port

Legal Services

*Timeout (Days)

Plan-DD Test

dmadmini@plandd-test.eurodyn.com

locathost

25

15

Application Temporary Directory

*Directory Path

Volume Configuration

fapplications/plandd/xchangs/tmp

*Recommended Number of Pages 300

Figure 50: Application Configuration Parameters

3. Click on Save Form button to confirm and save the changes.

You can also use the Reset Form button before you save the form, in order to undo the modifications.
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3.9.2 Adapters Configuration Parameters
In order to set or edit the Adapter Configuration Parameters:

1. Select Administration > Configuration Parameters - Adapters

Administration
Configuration Parameters ¥ Application
Arcquis List ¥| Adapters

You can also access the Adapters Configuration Parameters form by selecting the Configuration Parameters
under Administration from the left navigation and then selecting the Adapters link.

2. In the displayed form you can fill or edit the following parameters:
e CCVista Configuration
e Ceres Configuration
e Demed Configuration
e Cellar Configuration
e EUR-Lex Configuration
e OJ Format Configuration
e OJ Format Cleaning Properties Configuration
e Printers Configuration
e Procat Configuration

e SICOF Configuration
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CCVista Configuration

*Web Service URL

“Web Service Namespace
*Connection Timeout (Seconds)
*Download Documents Limit
*Username (Proofreading)
*Password

Procat Configuration
*Inbox Directory

*Archived Directory

*Failed Directory

*Outbox Directory

“Procat Server Outbox Directory
“Connection String
OJ-Format Configuration
*Inbox Directory

*Archived Directory

*Failed Directory

*Qutbox Directory
ClearMD Configuration
*Inbox Directory

*Archived Directory

*Failed Directory

*Outbox Directory
EUR-Lex Configuration
*Inbox Directory

*Archived Directory

*Failed Directory

*Qutbox Directory

Cellar Configuration
*Inbox Directory

*Archived Directory

*Failed Directory
*Documents Outbox Directory
*Acquis List Outbox Directory
Demed Configuration
*Document Request Queue
*Volume Request Queue
Ceres Configuration
*Inbox Directory

*Archived Directory

*Failed Directory

*Qutbox Directory

Printers Configuration

*Inbox Directory
*Archived Directory
*Failed Directory
*Outbox Directory

SICOF Cenfiguration

*Outbox Directory

Dashboard Export Configuration

*Outbox Directory

[beepzs s

13tatest. taiei be/livalink.asme

[neep:sccvistatest.aten.bes LiveLink

| 7appiications/planca/ xchange/procatx/inbox/ incoming

[7appiications/plancas xchange/procatx/inbox/ archives

[rappications.piansas

ange/procatx/inbox/falled

[rappications.piansas xcnange procatx/outbox

[rappications.procatum sxchange/panaasoutbax

[morm aamn -0 prozats 7 procatoa33 -A DORIS -NUNPORT 5015 CHROND SGTRACE 3 -L0G -autesomme

| rappiications/plansas xchange /ojformat sinbox/incoming

[rappiications/plancas

change/ojformat finbox/archived

| 7appiications/planca/ xchange /oiformat /inbox/ failed

[7appiications/planca/ xchange /ojformat /outbox

[rappications.piansa/xcnanges ciearmasinboxincoming

[rappications.piansas

change/clearma/inbow/archived

[rappications.piansas

ange/ clearmad/inbox /failed

[rappiications.piansas xcnange s ciearmasoutbax:

[ rappiications/planad/ xchange/ eurlex /inbax /incoming

[ rappiications/planca/ xchange /euriex/inbox archivea

| 7appiications/plancas xchange/ euriex/inbax failed

| 7appiications/plancas xchange/ euriex/outbox

[rappications piansa/xcnanges cotar rinbox sincoming

[rappications piansa/xcnanges cotar rinbox sarcnivea

| rappications.piansas wcnange s cetar rinbox sfaies

[rappiications/plancas

change/ celar foutbox/documents

[rappiications/plancas

change/ cellar foutbox/acquistist

[ims.cemea.requestquee |

[ims.cemea.jo.Requestqueue |

[7appiications/planca/ xchange / ceres/inbox/incoming

| 7appications/planca/xchange/ceres/inbox/archived

| 7appiications/plancasxchange/ ceres inbax/Taied

| 7appiications/planca/ xchange /ceres/outbox

[rappications/pianaas

ange/printers/inbox/incoming

[rappications/pianaa/xchangesprinters inbox archives

[rappiicationspiansasxchangesprinters inboxfatea

[rappicationspiansa/xchangesprinters outbox

[7appiications/pianaasxchange sicotsoutbax

[iom

tions/plandd/xchange / dashboard/ outbox
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Figure 51: Adapters Configuration Parameters

3. Click on Save Form button to confirm and save the changes.

You can also use the Reset Form button before you save the form, in order to undo the modifications.

3.10 Manage Acquis List

3.10.1 Initialisation of the Acquis List from zip archive
In order to initialise an Acquis List from a zip archive:

1. Select men File > Upload Acquis List

Help Shift+H
About Plan-DD

IUpload Acguis List

Logout sShift+0

2. In the displayed form fill in the mandatory fields. Select the Language from the drop down list and then
use the Browse button in order to locate the zip file that you want to upload.

Note: The zip archive should have been retrieved from CCVista, containing the priority list chapters in MS Excel
format and has been stored locally in your PC. In addition, the Excel files should have the correct structure as they
are downloaded from the CCVista.
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Upload Acquis List

Select a language:

Enlargement: Enlargment 2012

Upload Acguis List from ZIP file: ! ![ Browse... ] =

The results of the import procedure will be e-mailed to all the members of the Technical Support Agents group:
Tech Support Agent (ED) «<pkava@esurcdyn.com=

Figure 52: Upload Acquis List

3. Click on Uploead button to confirm the selection of the file and start the uploading

4. A message will be displayed informing the user if the import method was launched successfully or if it was
aborted due to errors.
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Launch of Import process :

Created temporary directory: AcguisListImport/pGSHfbtnrd
Launching import method...

Import method launched successfuly.

Figure 53: Launch of Import process

5. Click the Close button in order to close the window and return to the previous screen.

3.10.2 Manual Management of the Acquis List
In order to add a new Document:

1. Select Administration 2 Acquis List 2 Add Document

Administration

Configuration Parameters »
Acquis List >| Add Document |

2. In the displayed form fill in at least the mandatory fields. Enter the Document Identifier, the Publication
reference and select from the corresponding drop down lists the Enlargement, the Chapter, the Status
and the Acquis update letter if available.
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Acquis List Management : Add a Document to the Acquis List

Document Identifier: |31995L-"” a *

Publication reference: 199003130038 |

Enlargement: | Enlargement 2012 v|

Chapter: 1 General, financial and institutional matters

Status: Included »

Acquis update letter: |R1 1t1 Dashboards.doc (2070652011 19:34) v|

Figure 54: Add new Document in Acquis List

3. Click on Save button to confirm the creation of the new Document

4. The created Document will be displayed in the Acquis List
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Enlargement:

Status: © Included @ Eccluded @ Al
Enlargement 2012

Administ ration/Acquis List Export to Excel

Acquis List

on Pagﬁ-nuf 1236 03 3
Document Identifier | X !L::-:a:e Document | * | X
Document Identifier Linked Publication reference Enlargement Chapter Status  Mumber of Pages
32008R0628 Eﬁ Enlargement 2012 {03 Agriculture included O
22008000 == Enlargement 2012 11 Exkternal relations Included O
2200800000 = Enlargement 2012 11 External relations Included O
3200800196 EE.. Enlargement 2012 07 Transport policy Included O
2200700100 Eé Enlargement 2012 11 External relakions Included O
3200800185 == Enlargement 2012 03 Agriculture Included O
32008ROT3T = Enlargement 2012 03 Agriculture Included O
2200700121 EE.. Enlargement 2012 11 External refations Included O
32009R0378 Eé Enlargement 2012 {03 Agriculture included O
3200800156 == Enlargement 2012 03 Agriculture Included O

Figure 55: Acquis List

Note: When creating a new document in the Acquis List, the exit point after the creation of the document is the
same with the entry point before selecting the option to add the new document.

3.10.3 View Documents in Acquis List

In order to view the list of existing Documents in the Acquis List:
1. Navigate to the Acquis List under Administration from the left navigation
2. Select the Enlargement by using the corresponding drop down list

3. Select one of the available radio buttons to filter the Documents depending on their status. Available
options are the “Included”, “Excluded” and “All”. By default the “Included” option is selected.

Every time a user selects an Enlargement or a Status, the results will be updated automatically. A value
labelled "Total Pages" will provide the total number of pages of the presented results.

4. You can use the Export to Excel | Export to Excel button, in order to export the results in Excel format

3.10.4 Edit Document in Acquis List

In order to edit an existing Document of the Acquis List:
1. Navigate to the Acquis List under Administration from the left navigation
2. Select the Document you want to edit

3. Right click and select Edit a Document in the Acquis List
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Document Identifier Linked Publication reference Enlargement Chapter Status
2199441223200 = Edit a Document in the Acquis List ternal relations Included
21986A0324(03) == Link Document(s} ternal relations Included
&= Unlink Document(s) riculbure Included
42005X1216(02) = Enlargement 2042 21 Temporary chapter for finilization Included

Figure 56: Edit Document in the Acquis List

4. In the displayed form edit the fields that you wish.

5. Click Save in order to close the form and save the modifications

3.11 Document Linking

3.11.1 Link Documents from Document Manager

In order to link one or more documents from the Document Manager:
1. Open the Document you want to link with the Document Manager
2. Click the Metadata button in order to open the Document LV Metadata page
3. At the bottom of the Metadata page, the Linked Documents list is displayed

Linked Documents :

4. Click the Add button to open the search form to Link Documents
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Please enter Document number and perform search to add a Linked Document :

The search form displays only documents that belong to the same main chapter and they are not attached to a volume of an

active enlargement.

Document Humber |

Documents List Linked Documents

Figure 57: Search form for Linked Documents

5. Enter a document number or the first part of it in the Document Number ficld and click the Search button
in order to get a list of documents in the Document List.
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Please enter Document number and perform search to add a Linked Document :

The search form displays only documents that belong to the same main chapter and they are not attached to a volume of an
active enlargement.

Document Number|319 |

Documents List Linked Documents

31958R0001 =
3196001027(01

3196400350

31967R0422

31967R0423

31968R0421

31969RO549

31969R1826

31969R2604

Figure 58: Search results in Documents List

6. Use the right and left arrows to add or remove documents to the Linked Documents list
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Please enter Document number and perform search to add a Linked Document :

The search form displays only documents that belong to the same main chapter and they are not attached to a volume of an
active enlargement.

Document Mumber [319 |

Documents List Linked Documents

3195801006(01) ~ 31953R0001

3196001027(01) 3196400350

J1967RO422
3196TR0423 n
31968R0421

31969R0549
31969R1826
31969R2604
3197000244
31970R2163

Figure 59: Added Linked Documents

7. Click on OK button to close the search form and confirm the list of Linked Documents

Linked Documents :

31964003550

Remove

8. Click on OK button of the Document LV Edit Metadata form in order to save the Metadata of the
document

9. You can also remove Linked Documents by selecting documents from the list and use the Remove button
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3.11.2 Link/Unlink Documents from Acquis List
In order to link one or more documents from the Acquis List:
1. Select the Acquis List under Administration from the left navigation

2. From the displayed Acquis List select the documents you want to link. You can select the documents by
pressing the Ctrl button of your keyboard and click once on each of the documents that you want to link

3. Select Administration 2 Acquis List 2 Link Documents from the main menu or right click on the
selected documents and select the Link Document(s) option.

Administration
Configuration Parameters 3
Acquis List ¥| Add Document
Enlargements ¥| Link Document(s)
Languages ¥| Unlink Document(s)
Chapters ¥| Acguis Update

4. A list of the selected documents to be linked will be displayed.

Acquis List Management : Link Documents

@ Are you sure you want to link the following Documents?

50 | ™

Publication reference: Document Identifier: Enlargement: Chapter: Status:
J2001RO045 Enlargment 2012 {1 General, financial and institutional matters Excluded

J2001R1049 Enlargment 2012 1 General, financial and institutional matters Included

32002R0029 Enlargment 2012 1 General, financial and institutional matters Included
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Figure 60: Acquis List Link Documents

5. Click on OK button to proceed with the linking of the documents.

In case that one of the selected Documents already belongs to another group, a message informing the user that
some documents are already linked will be displayed and the action is cancelled.

@ Are you sure you want to link the folowing Documents?

These Documents cannot be linked because some of them belong already to other groups.

50 |

% % Enlargement: Chapter: Status:
1 General, financial and institutional

32002R0029 Enlargment 2012 matters Included
01 General, financial and instituticnal

32002R0204 Enlargment 2012 makters Included
Automatic Update 01 General, financial and institutional

32002R0204 Enlargement matters Included

32002R0204 Enlargment 2012 13 13.30.14 Foodstuffs Included

Automatic Update
32002R0204 Enlargement 13 13.30.14 Foodstuffs Included

Figure 61: Link can not be performed
In order to unlink a document from the Acquis List:
1. Select the Acquis List under Administration from the left navigation

2. From the displayed Acquis List select the document you want to unlink.

3. Select Administration = Acquis List = Unlink Documents from the main menu or right click on the
selected documents and select the Unlink Document(s) option.

Administration
Configuration Parameters k
Acquis List k| Add Document
Enlargements ¥| Link Document(s)
Languages ¥ Unlink Document(s)
Chapters ¥| Acguis Update
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4 General Coordinator/Production Agent

4.1 General Coordinator’s Inbox

Logged in as general coordinator | Logout  Help

Plan-DD Er—

§# plandd_prod : General Coordinator (ED) File Edit View Tools Administration
S Inbox
), Saved Searches

tions

Inbox (plandd_prod) 1 am available Show Al (Hide Attachments) |

o Cabinsts Items per page: [RIENE"S
Add Repository [

Subject | From | Date Received | Due Date| Status| Repository|

H I- Abort Workflow  dmadmin 107052011 15:41

. |. Abort Workflow  dmadmin 10/05/2011 15:39

Figure 62: General Coordinator's Inbox

4.2 Edit Document LV Metadata
In order to edit the metadata of a Document LV:
1. Access the Document LV for which you want to edit the metadata

2. Select Edit > Edit Document LV Metadata from the menu on the Web top or click on the Metadata
button

Edit View Tools Administration

Edit Document LY Metadata

Update Metadata From Procat
3. The Document LV Metadata form is displayed

4. Modify the properties that you want
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Document LV Edit Metadata :

Document Identifier : |

Publication|

Reference :

Language : HR

Chapter :

=

Sub-chapter : | 01.40 Provisions governing the institutions

LT D SO ETS SNl (11 General, financial and institutional matters
Sub-chapters : ||01.40 Provisions governing the institutions

Document Status : | Prior-Reading W

CC Vista Status : Under finalisation
Skip 0J Format : Mo
Author Files Status: No
Model Files Status: Ves
Publication date :
Volume Mame :

Official title :

English title :

French title :

Figure 63: Document LV Metadata form

5. Click on OK button to save the modifications.

4.3 Manual Upload/Update of Document LV

4.3.1 Upload Document LV
In order to upload a Document LV:

1. Select File > Manual Upload/Update of Document LV
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Administ ration

Help Shift+H
About Plan-DD

Manual Upload/Update of Document LV
Upload Acquis List

Logout shift+0

2. In the displayed form fill in at least the mandatory fields. Enter the Document Identifier or use the Search
button in order to select a Document that exists in the corresponding Acquis List. Fill in a document
identifier or the first part of it and click the Search button. A list with all the document identifiers starting
with the part you have entered will be displayed. Select the radio button in front of the document identifier
that you want to select and then click the OK button to confirm the selection. The selected value will be
inserted in the Document Identifier field of the Document Upload form.
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Document Upload : Update Document

Document Identifier Public Reference English Title
31999R1074

31999Y0317(01)

3200100079
J1998R2679
3199900132
J2006R1791
J2007ROBG4

32008R0593

O
O
O
O
O
O
o
O
O
O

3200900026

Figure 64: Search Document Identifier

3. Continue by selecting from the corresponding drop down lists the Language and the Task whether is for
Prior-Reading or Control Reading. Optionally, you can also add some comments in the Comments field
and select the Exclude OJ-Format check box in order to exclude the document from the OJ-Format.
Finally, use the Add Files button in order to browse and add to the list the files that you want to upload or
drag and drop.
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Document Upload : Update Document

INFORMATION: The upload procedure may take a few minutes. Please do not close yvour browser.

Document

31985004664 Search
ldentifier | -
Language |HR w

Task Prior-Reading |v

Acquis list
Excluded
status

Comments:

|:| Exclude OJ-Format

Selected Files:

B Document_LY doc

Add Files Remove

Mandatory fields

Figure 65: Upload Document LV

4. Click on OK button to confirm the uploading of the Document LV

When the uploading is completed, the Document Manager of the Document to which the Document LV was
uploaded will be displayed with the Document LV attached and the selected workflow (Prior-Reading or Control
Reading) will be initialised.
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Display [Savel File

=]

31988L0667-HR

L&

31988L0667-HR.doc

plandd_test / Plan-DD / Enlargement 2012 / 13 Industrial policy and internal market / Documents / 1988 L0667 / 31988L0667-HR
Document 31988L0667-HR

Document ldentifier 3198BL06KT Started In progress Completed
Language HR Procat [ ]
Chapter 13 Industrial policy and internal market 0OJ-Format .
Publication Reference  1988L382p0046 R
Control-readin [ ]
Publication date £
Property Cleaning
Number of pages 3
EUR-Lex
Volume Name
Cellar
CCVista Status Finalised
State Legend : @ Valid @ Disabled ® Invalid
Acquis list status Included

Procat update date 0d-Aug-2011

Council Directive 88/667/EEC of 21
December 1988 amending for the fourth time
Directive 76/768/EEC on the approximation
of ...

Title EN

Mot &vsilable Prior-Reading Legal Finslisstion Reachy for Printer Publizhed

Hame Version Modifier Modified Full Content_size Format

@ 31988L0667-HR.doc CURRENT,1.0,Finalised dmadmin 01/07/2011 12;08 5Z KB M5 Word 4.x, ...

Figure 66: Document Manager with Document LV

4.3.2  Correct wrong or corrupted Document LV

In case that a Document LV file with incorrect content has been uploaded:

1.
2.

Select File > Assign Task from the main menu

Locate the task that has been created after the manual upload of the specific Document LV by using the
available filters.

Select the task by using the corresponding check box and click the Abort Task button in order to abort the
task.

In case a Prior Reading workflow has already been started and the task exists in the users Inbox, the
Proofreader can navigate to the task and select to reject the task by using the Reject button.

After executing one of the above actions to stop the started workflow, Production Agent or General
Coordinator can upload a new file with the correct content for the specific Document LV.

Note: the Reject button is not available for the Control Reading tasks
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In case that a Document LV file with incorrect file name has been uploaded:

1. Select File 2 Check Out from the main menu (option is also available under right click menu on the
Document LV)

2. Select File > Check In from the main menu (option is also available under right click menu on the
Document LV)

3. In the Check In form modify the document name and click the OK button to check in the file

Note: After changing the name of the Document LV file (if OJ-Format is not excluded), the pending OJ-Format
response will not match any Document LV file. As a result the Document LV files will miss their cleaned content.

4. Select Edit 2 Send to OJ-Format main menu in order to overcome the above mentioned possible issue.

4.3.3 Update Document LV

In order to update an existing Document LV:

1. Navigate to the Document Manager where the Document LV to be updated is already attached

2. Select the Document LV you want to update
3. Select File 2 Manual Upload/Update of Document LV

File Edit View Tools Administration

Help
About Plan-DD

Manual Upload/Update of Document LY
Upload Acquis List

Logout

Shift+H

Shift+0

4. The Update Document form will open

Issue Date:

09/12/2011

Document File Name:

D.PDD.UMA-2.2.0 - User Manual v0.05.doc

Page:
73 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

Document Upload : Update Document

INFORMATION: The upload procedure may take a few minutes. Please do not close your browser.

Document
Identifier

Language |HR

Task Prior-Reading

Acquis list
status

Excluded

Comments:

|:| Exclude OJ-Format

Selected Files:

Add Files Remove

Mandatory fields

Figure 67: Update Document LV

5. Update the fields accordingly and use the Add Files button in order to browse and add the updated file that
you want to upload. You can also add files by using the drag and drop functionality.

6. Click OK in order to upload the updated file and save the modifications

4.4 Change the status of a Document LV
In order to change the status of a Document LV:
1. Access the Document LV of which you want to change the status

2. Select Edit 2> Edit Document LV Metadata from the menu on the Web top or click on the Metadata
button
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Edit View Tools Administration

Edit Document LY Metadata

IUpdate Metadata From Procat
3. The Document LV Metadata form is displayed

4. Select the desired status from the Document Status drop down list

5. Click on OK button to save the new status of the document.

4.5 View Documents in Acquis List

In order to view the list of existing Documents in the Acquis List:
1. Navigate to the Acquis List under Administration from the left navigation
2. Select the Enlargement by using the corresponding drop down list

3. Select one of the available radio buttons to filter the Documents depending on their status. Available
options are the “Included”, “Excluded” and “All”. By default the “Included” option is selected.

Every time a user selects an Enlargement or a Status, the results will be updated automatically. A value labelled
"Total Pages" will provide the total number of pages of the presented results.

4. You can use the Export to Excel M button, in order to export the results in Excel format

4.6 Update Metadata from ProCat
In order to update the Metadata from ProCat:
1. Access the Document LV for which you want to edit the metadata

2. Select Edit > Update Metadata From ProCat from the menu on the Web top.
Edit View Tools Administration

Edit Document LV Metadata

|Ipdate Metadata From Procat

3. A message is displayed about the action that will follow and a confirmation is requested

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 75 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

Update Metadata from Procat :

@ The update of metadata from Procat will take some time until completed. Are you sure you want to continue?

Figure 68: Document LV Metadata form

4. Click on OK button to proceed with the Metadata update.

After the confirmation from the user, a request is sent to ProCat and upon response the metadata will be updated
accordingly.

4.7 Upload files

4.7.1 Upload the Model
In order to upload a Model:
1. Access the Document LV for which you want to upload the model

2. Select File » Upload Files from the menu on the Web top.
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File Edit WView Tools Administration

Mew 3

Help Shift+H

About Plan-DD

Manual Upload/Update of Document LY

Assign Task

Upload files

Logout Shift+0

3. The Upload Files form is displayed

Upload Files :

INFORMATION: The upload procedure may take a few minutes. Please do not close vour browser.

Choose

tvpe:

Selected Files:

Add Files Remouve

Mandatory fields

Figure 69: Upload Model
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4. Select Models from the Choose Folder drop down list
5. Click the Add button and browse the model that you want to upload or drag and drop the file
6. Click on OK button to proceed with the linking of the documents.

4.8 Manual download of CCVista documents
In order to manually download the CCVista documents:

1. Select File 2 Manual download of CCVista documents from the menu.

File Edit View Tools Administration
[ew 3
Help shift+H

About Plan-0D

Manual Upload/Update of Document LY
Manual download of CCVista documents

Assign Task
Ipdate Ready for Press Template

Logout Shift+0

2. The Manual Download of Documents from CCVista form will be displayed
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Manual Download of Documents from CCVista

Languages Selected Languages

Enlargements

Real-time CCVista

Status C‘ Revized C‘ Finalized O Both

Upload Document List |

Figure 70: Manual Download of Document from CCVista

3. Use the “Add” u and “Remove” n buttons and move the preferred Languages to the “Selected

Languages” list.

Select the preferred CCVista Status by selecting the corresponding radio button.
Browse the MS Excel file to be uploaded.

Click the Upload button in order to start the uploading of the CCVista list.

NS v ke

The Verification of Documents to Download form is displayed providing a list with all the loaded
Celexes.
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Verification of Documents to Download

Real-time
CCVista Verification
Status

Document Language Enlargement Acguis List Document LV
Identifier EuaE 4= status Status

MOK: CCVista status not in
Enlargement 03 Under proof- |Revised or Finalised:
3198600200 ] 2013 Agriculture Prior-Reading reading Document is ignored.

HOK: CCVista status
Enlargement 03 Under proof- |Revised or Finalised:
31996R1095 2013 Agriculture Included  Prior-Reading reading Cocument is ignored.

Figure 71: Verification of Documents to Download

In the Verification column, information is displayed about the check that performed against CCVista statuses. An
"OK" is displayed for documents having no warnings and a "NOK" is displayed for documents having issues in
their format followed by an explanation.

8. Click the Download button Bkl in order to start downloading the documents asynchronously.

An e-mail notification with the results of the downloaded documents, as an attachment in MS Excel format, is sent
to General Coordinators and Production Agents when the download is finished. This e-mail includes in addition
to the detailed results, the total number of documents downloaded and the total numbers of documents that are not
OK (per status). The detailed results are displayed ordered by status, having the OK at the top.

4.9 Create Volume
In order to create a new Volume:

9. Select File > New > Volume from the menu on the Web top.
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Edit View Tools Administration

[ew ¥ Volume

10. The Create New Volume form will be displayed

Create New Volume :

Chapter : | 01 General, financial and institutional matters

Language : £

Vaolume Humber : |1}DE

Catalogue Number : py_pz- -HR-C

Vaolume Year: |

Publication Date : | Date lﬂ*_}

Printer : | 10288/ Euroscript

Assignee : | Production Agent (ED)

Create Volume Cancel

Figure 72: Create New Volume form

11. Fill in all the appropriate data using the drop down lists or the corresponding fields.
12. Click the Save button in order to save the new Volume.

Note: Catalogue digit part of the catalogue number will be always formatted as 3 digits with leading zeroes. In case
the digit part of the catalogue number is more than 3 digits, the system will accept the number as it is without
modifying it or by adding any extra leading zeroes.
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4.10 Edit Volume Metadata

In order to edit the metadata of a Volume:
1. Access the Volume for which you want to edit the metadata
2. Click on the Metadata [IEEEEES button
3. The Edit Volume Metadata form is displayed

Edit Volume Metadata :

Chapter : 20 People’s Europe

Language : HR

Volume Number : 001
Catalogue Number : py.az. EI -HR-C

Yolume Year: |2EI11

Publication Date : |1}4-ﬁ~ug-2ﬂ1 1

Printer : | 10288 /Euroscript

Total Pages: 12

TOC Pages : |3

Volume Status : |Publ1'5hed W[

Assignee : |General Coordinator (ED) V|

DEMED Reference : 9340
DEMED 5tatus : PUBLISHED
DEMED Progress : COMPLETE

Figure 73: Volume Metadata form

4. Modify the properties that you want

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 82 of 142




Project / Subproject:
PLAN-JO No. 10238

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

PLAN-DD USER MANUAL

5. Click on Save button to save the modifications

4.11 Attach/Detach Document to Volume
In order to attach a document to a Volume:

1. Access the Volume to which you want to attach the document

2. Click on the PPF |m button
3. The Print Production File form is displayed

Print Production File :
Volume Functions Document Functions Ready for Press

Volume-01-002-HR Mov 14, 2011 10288/Euroscript Total Pages: 2 Status: Prepare Demed Status: DATA_CHANGE Language

TOC Pﬁges: Document Titles: @ show O Hide

Do t Publicati
O Jocument LUl ahon Status  Included/Excluded Comments

Identifier Reference

Decision creating the "Official Journal of the Europsan Communities’

P TR Prior- ~
O @ :195801008001) 1958P017p0590 Reading Included 1

63/32FEEC: Council Decision of 18 December 1962 on the determination of the appointing autherity for the Audit Board

. imn Mot ~
0 @ 3198300032 1963P012p0139 mtanie Included 2 z 1|

Figure 74: Print Production File Form

4. Select Document Functions = Attach a Document from the menu.

Document Functions Ready for Press
Attach a Document

5. The Attach Document form is displayed
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Attach Documents :

~
Select Document LVs to attach to the Volume-13-003-HR.
Volume Number : 003
Languages : HR
Main Chapter of Volume : 13 Industrial policy and internal market
Total Pages : 232
Selected Pages : 124
Starts with o [ x| Include Attached Documents : () ves (%) No
Document Identifier Publication Reference Pages Document Status Assignee Volume Volume Status
% 3200600215 0 Mot Available
% 3200600215 0 Hot Available
B 31994L0060 0 Mot Avaiable
B 319940027 0 Mot Avaiable
% 3196700548 1967F196p000 Q Hot Available
% 397IL01ZT 1971L068p00M ] Hot Available
% 3197Lzy 1971L068p00MM 0 Mot Available
% 31971L0317 1971L202p0014 0 Mot Available
% 31971L0317 1971L202p0014 0 Mot Available
% 3197100347 1971L239p000M 0 Hot Available
% 3197100347 1971L239p000 ] Hot Available
% 3197100349 1971L239p0015 ] Hot Available
% 319710L0349 1971L239p0015 ] Hot Available
% 3197200221 1972L133p0057 ] Hot Available
% 3197200221 1972L133p0057 0 Mot Available
% 3197300044 1973L083p00M 0 Mot Available
@ w

Figure 75: Attach Document Form

The Documents displayed in the “Attach Documents” form are displayed in a specific order. All Documents that
belong to the same chapter and included in the same Enlargement are displayed. In that list, Document LVs that are
attached to another volume are presented only in case they have status Prepare and Legally Validated. The status of
each Document LV is indicated. The Document LVs are listed according to their Publication Reference. In case
linked Documents are included, they are displayed according to the following rules:

Linked documents of the same group will be ordered together

The linked documents start position in the document listing is denoted by the older publication
reference of a document in the group in relation to a non-linked document or to another leading
linked document. The rest linked documents of the group are following immediately and they are
ordered by publication reference ascending sorting.

Non-linked documents will continue to obey the default publication reference ascending sorting

6. Select the document you want to attach from the list or locate it by using the Starts with field

7. Click on Attach button to save the modifications
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In order to detach a document from a Volume:

1. Access the Volume from which to detach the document

2. Click on the PPF |m button

3. The Print Production File form is displayed listing all the already attached Documents

Print Production File =
Volume Functions Document Functions Ready for Press

Volume-01-002-HR Mov 14, 2011 10288/Euroscript Total Pages: 2 Status: Prepare Demed Status: DATA_CHANGE Language

TOC Pages: Document Titles: @ show O Hide

Do t Publicati
O ZoCument —uieation Status  Included/Excluded

ldentifier Reference
Decision creating the "Official Journal of the Europsan Communities’
Prigr-

3195801006(01) 1958P017p0390 Included 1
O o - F Reading newes

63/32fEEC: Council Decision of 18 December 1962 on the determination of the appointing authority for the Audit Board

» o Hot i
0O @ 3198300032 1963P012p0139 entae Included 2 2 |1 ||

Figure 76: Detach Document Form

4. Select the documents that you want to detach by selecting their corresponding check boxes.

5. Select Document Functions = Attach a Document from the menu.

Document Functions Ready for Press
Attach a Document

Detach Document(s)
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6. A confirmation message will be displayed asking if you are sure that you want to detach the selected

7.

documents

Click on OK button to confirm the action

4.12 Change the Document order in PPF

The Document LVs are listed according to their Publication Reference. In case linked Documents are included,
they are displayed according to the following rules:

e Linked documents of the same group will be ordered together

e The linked documents start position in the document listing is denoted by the older publication
reference of a document in the group in relation to a non-linked document or to another leading
linked document. The rest linked documents of the group are following immediately and they are
ordered by publication reference ascending sorting.

e Non-linked documents will continue to obey the default publication reference ascending sorting

In order to change the order in which documents are displayed in the PPF:

1. Access the PPF in which you want to change the order of the documents
2. Select the document of which you want to change the order by selecting the corresponding check box in
front of the document.
3. Select Document Functions > Move Document(s) from the menu
Ready for Press
Move Document(s)
Total Pages: 3
4. The Move Documents in the Print Production Form of the Volume form opens
Issue Date: Document File Name: Page:
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Move Documents in the Print Production Form of the Yolume :

@ Please select a Document LV of the Volume

Document Identifier Publication Reference Status Included/Excluded

31958D1006(02) 1958B017p0419 Priar-Reading Included

@ Please select the relative position of the selected Document LVs

Relative Position:  (3) Before Selected Document () After Selsctsd Document

Figure 77: Move Documents in the Print Production Form

5. Select the Document LV from the list of Documents which will be used in order to define the relative
position of the previously selected Document. Only one Document LV should be selected to be moved
each time.

6. Select the Relative Position by using the corresponding radio buttons in order to define if the initially
selected Document will be moved before or after the selected Document in the Move Documents in the
Print Production Form of the Volume form.

7. Click the OK button in order to confirm the action.

Note: If a new Document is attached, it will be positioned after the Document where it would otherwise follow in a
non-manually ordered PPF. If a Document is detached, this action will not cause any additional re-arrangement on
a manually arranged PPF. Its position will be filled in with the next Document

In case you select all of the available Documents to be moved, the message “You are not allowed to move all
Document LVs of PPF” will be displayed.
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In order to reset the Documents order:

L.

2.

3.

Select the Document Functions = Reset Document Order menu

Document Functions Ready for Press

Reset Document Order Total Pages: 3

Click the OK button to the confirmation window in order to proceed to the reset of the Documents
ordering.

The PPF form will be displayed with the Documents order reset with the initial ordering.

4.13 Export Letter for Legal Services/Inform Legal Services

In order to export a letter for the Legal Services:

L.

2.
3.

4.14

Access the Volume from which you want to export the letter

Click on the PPF |m button
The Print Production File form is displayed

Select Volume Functions 2 Export Letter for Legal Services from the menu.

Volume Functions Document Functions
Export Letter for Legal Services
Legal Services Informed
Send Budget Request
Send Publication request to Printer

A letter based on a template is generated which contains information for the Document LVs to be printed
along with the current Volume

After signing and sending the letter, select the option Volume Functions = Legal Services Informed to
inform the system that the Legal Services have been informed.

Validation Received from the Legal Services

In order to confirm the valid reply received from Legal Services:

1. Access the Volume for which you want to confirm the validation received.
2. Click on the PPF |m button
3. The Print Production File form is displayed
4. Select Volume Functions - Valid Reply from Legal Services from the menu.
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Volume Functions Document Functions

Edit Volume metadata
Export Letter for Legal Services

Valid Reply from Legal Services
Invalid Reply from Legal Services
Send Budget Request to DEMED

A confirmation message is displayed.
Click on OK button in order to confirm the action.

The status of the Volume changes to “Legally Validated” successfully

© N oo

The functions Valid Reply from Legal Services and Invalid Reply from Legal Services are disabled

4.15 Rejection Received from the Legal Services
In order to confirm the invalid reply received from the Legal Services:

1. Access the Volume for which you want to confirm the rejection received.

2. Click on the PPF |m button
The Print Production File form is displayed

4. Select Volume Functions 2 Invalid Reply from Legal Services from the menu.

Document Functions

Edit Volume metadata
Export Letter for Legal Services

Valid Reply from Legal Services
Invalid Reply from Legal Services
A confirmation message is displayed.
Click on OK button in order to confirm the action.
The status of the Volume changes to “Prepare” successfully

The function Legal Services Informed is enabled.

° © N W

The functions Valid Reply from Legal Services and Invalid Reply from Legal Services are disabled

4.16 Upload the Confirmation/Rejection Letter received from the Legal Services
In order to upload the confirmation or rejection letter that has been received from the Legal Services:

1. Access the Volume for which you want to upload the confirmation or rejection letter.

2. Click on the PPF |m button
The Print Production File form is displayed

4. Select Volume Functions - Upload Files from the menu or File > Upload files from within the Volume
Manager
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Volume Functions Document Functions

Edit Volume metadata
Export Letter for Legal Services

Send Budget Request to DEMED

Send Publication request to Printer
IUpload files

5. The Upload Files form is displayed

Upload Files =

INFORMATION: The upload procedure may take a few minutes. Please do not close your browser.

Upload of volums proofs is permitted only when the status of the Volumes is Ordered, Proofreading or Ready for Publication.

Choose
tvpe:

Selected Files:

Add Files Renmouve

Mandatory fields

Figure 78: Upload Files Form

6. Choose the file Type from the corresponding drop down list.
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Browse and attach the file(s) by using the Add Files button or by using the drag and drop action. The
possibility to upload multiple files is available as there might be several requests to Legal Services per
volume.

Click on OK button to save the modifications

4.17 Send Budget Request to DEMED
In order to send a Budget Request to DEMED:

1. Access the Volume for which you want to send the budget request
2. Click on the PPF |m button
The Print Production File form is displayed
4. Select Volume Functions = Send Budget Request from the menu.
Edit Volume metadata
Export Letter for Legal Services
Send Budget Request to DEMED
5. A confirmation message is displayed in order to ask the user to proceed with sending the information to
DEMED
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Send information to DEMED

@ Are you sure you want to send the information to DEMED ?

Figure 79: DEMED Confirmation message

6. Click on Send to DEMED button to send the request to DEMED.

In case the Volume Year has not been set in the Volume Metadata Form, a blocking message will be displayed

informing the user that the information can not be sent to DEMED.

Send to DEMED

Issue Date:

09/12/2011

Document File Name:

D.PDD.UMA-2.2.0 - User Manual v0.05.doc

Page:
92 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

Send information to DEMED

Q The information cannot be sent to DEMED as the Volume Year for the Volume-01-007-HR is not setin the volume metadata form.

Figure 80: Send information to DEMED is blocked

4.18 Edit and Dispatch Publication Request to Printer
In order to Dispatch a Publication Request to a Printer:

1. Access the Volume for which you want to dispatch the publication request

2. Click on the PPF |m button
3. The Print Production File form is displayed

4. Select Volume Functions = Send Publication request to Printer from the menu.

Volume Functions Document Functions
Export Letter for Legal Services
Legal Services Informed
Send Budget Request
Send Publication request to Printer

5. The Publication Request form is displayed
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Publication Reguest

@ The Publication Request can not be sent to the printer as there are attached document LVs that have status different from "Ready

for printer
Volume :
Language :
Chapter :

Printer :

Catalogue Number :

Publication date

Files:

Volume-01-007-HR
HR

01 General, financial and institutional matters

10288/Euroscript
FX-AZ-13-060-HR-C

|Batc— ﬁ' Time

Proofs : |Date @Y- Time

Passed for press: |Date ET. Time

Electr. version: l:l

Prioreading: () ves & Ho
Proofreading : () ves & o
XML preparation: () ves & Ho

Comments :

Other contact = |

Signed by :

Figure 81: Publication Request form

6. Fill in all the required data for the Publication Request

7. Click on Send to Printer button to send the request to the Printer.

Note: The Publication Request as well as the reply from the Printer will be saved in the Correspondence folder of
the Volume. After the Publication Request Acknowledgment from the Printer is received, the Volume Status will
be changed to “Ordered”, the Volume state “Publication Request” changes to “Started” and the corresponding audit
event is saved in the Audit trail.

4.19 Manual Upload of Volume Proofs from Printer
In order to manually upload a Volume Proof from Printer:

1. Access the Volume for which you want to upload the Proofs

2. Click on the PPF |m button
The Print Production File form is displayed

4. Select Volume Functions = Upload Files from the menu.
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Print Production File :

Volume Functions Document Functions
Export Letter for Legal Services
Legal Services Informed
Send Budget Request to DEMED
Send Publication request to Printer
Upload files

5. The Upload Files form is displayed

Upload Files :

INFORMATIOMN: The upload procedure may take a few minutes. Please do not close your browser.

Upload of volume proefs is permitted only when the status of the Volume is Ordered, Proofreading or Ready for Publication.

e
folder: reots

Selected Files:

Add Files Remove

Mandatory fields

Figure 82: Upload Files

6. Make sure that Proofs is selected in the Choose Folder drop down list

7. Click the Add Files button in order to browse and select the proofs from your local drive or use the drag
and drop action.

8. After selecting the files, click on OK button to confirm the uploading of the files

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 95 of 142




PLAN-DD USER MANUAL

Project / Subproject:
PLAN-JO No. 10238

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

The Proofs from Printer can also be uploaded from the Volume Manager, by using the File = Upload Files option

from the main menu.

4.20 Dispatch the Proofs to Printer

In order to dispatch the Proofs to Printer:

1. Access the Proofs folder where the Proofs you want to dispatch are located

2. Select the Proofs that you want to dispatch

3. Select File 2 Dispatch proofs to Printer from the menu.

Edit View Tools Administration

Mew

Edit
Cpen (Read Only)

Chedk Qut

Export

Add to Favaorites

Help
About Plan-0D

Manual Upload/Update of Document LY
Assign Task

Upload files

Ipdate Ready for Press Template

Dispatch proofs to printer

Logout

Shift+E

Shift+H

Shift+0

4. A confirmation message is displayed to select whether you want to proceed with the dispatch

5. Click the Dispatch button in order to proceed

4.21 Manage Ready for Press Form

In order to edit the Ready for Press form:

1. Access the Volume for which you want to edit the Ready for Press form

2. Click on the PPF |m button

3. The Print Production File form is displayed
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4. Seclect Ready for Press > Edit Ready for Press from the menu.

Ready for Press
Edit Ready for Press
Upload Ready for Press

5. The Ready for Press form is displayed

Ready for Press
)

0J / ABI LIVRAISON / LIEFERUNG : Versien électronigue / elektrenische Fassung
Lo Volume-01-006-HR. DATE/DATUM:  Heure/Uhrzeit: 0:0

dus/vem 707

Humber of pages in the PPF: g9

LIVRAISON f LIEFERUMNG : Version papier / Papierausgabe

pages/Seiten I:I DATE/DATUM:  HeurefUhrzeit: 0:0
Imprimerie/Druckerei: 10288/ Euroscript

HR

Werpackt und etikettiert an das Amt fiir Verdffentlichungen (Gasperich) zu liefern/Alivrer sous emballage £tiquete a lOffice des publications (Gasperich)

Archive

I

Affichage réception

'
I

Infotechnigue

I
I

Stock

I
I

Menge fiir Direktversand: lose (auf Paletten oder in Containern) an das Amt fiir amtliche
Verdffentlichungen (Gasperich) zulisfern/ Exemplaires pour diffusion a livrer (sur palettes ou dans
des conteneurs) i Office des publications officielles des C 25 europé (Gasperich)

"]
]

Commande spéciale

7]
[°]

[ remove ling add line
AUFLAGE

w

0 =

Figure 83: Ready for Press Form
Fill in all the necessary information
Click the Save button in order to save the modifications and return to the PPF form

Click the Save and Print button to Print the Ready for press form

A S

The Ready for Press is exported in PDF format and is opened in a separate window to be printed
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A RFP_Volume-13-003-HR. pdf - Adobe Reader

File Edit WYiew Document Tools ‘Window Help ®
=28 EENCICTASN-] ¥ | C—

OFFICE DES PUBLICATIONS DE L'UNION EUROPEENNE OP/A/JOLC AMT FUR VEROFFENTLICHUNGEN DER EUROPAISCHEN UNION

0J /1 ABI LIVRAISON/LIEFERUNG :

Version électronique / elektronische Fassung
L O Volume-13-003-HR
dufvom 11/07/11 DATE/DATUM:
: LIVRAISON / LIEFERUNG :
pagesiSeiten 0 Version papier / Papierausgabe
Imprimerie/Druckerei: 10202 LOT 2: Euroscript DATE/DATUM:

BORDEREAU DE LIVRAISON VERSANDLISTE

HR
Verpackt und etikettiert an das Amt fiir Versffentlichungen (Gasperich) zu liefern/A livrer sous
emballage étiqueté & I'Office des publications (Gasperich)
Archive 10
Affichage réception 5
Infotechnigue 2
Stock 15
Menge fiir Direktversand: lose (auf Paletten oder in Containem) an das Amit fiir Verdffentiichungen
(Gasperich) zu liefern/Exemplaires pour diffusion a livrer (sur palettes ou dans des conteneurs) a I'Office des

ublications (Gasperich)

Commande spéciale 15
AUFLAGE 52

Figure 84: Print Ready for Press

In order to view the Ready for Press form:

1. Access the Volume for which you want to edit the Ready for Press form

2. Click on the PPF |m button
The Print Production File form is displayed
4. Select Ready for Press 2 View Ready for Press from the menu.

Ready for Press
Edit Ready for Press
View Ready for Press
Upload Ready for Press
View Signed Ready for Press

5. The Ready for Press form is displayed

In order to upload the Ready for Press form:

1. Access the Volume for which you want to edit the Ready for Press form

2. Click on the PPF |m button
3. The Print Production File form is displayed
4. Seclect Ready for Press = Upload Ready for Press from the menu.

Ready for Press

Edit Ready for Press

View Ready for Press
IUpload Ready for Press
View Signed Ready for Press
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5. The Upload Signed Ready for Press form is displayed

Upload Signed Ready for Press PDF :

INFORMATION: The upload procedure may take a few minutes. Please do not close your browser.

Selected Files

Add Files Remoue

Mandatory Fields

Figure 85: Upload Signed Ready for Press Form

6. Click the Add Files button and browse the file to be uploaded or use the drag and drop action
7. Click the OK button in order to confirm the selection and upload the file

In order to view the signed Ready for Press:

1. Access the Volume for which you want to edit the Ready for Press form

2. Click on the PPF |m button
3. The Print Production File form is displayed
4. Select Ready for Press 2 View Signed Ready for Press from the menu.
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Ready for Press

Edit Ready for Press

View Ready for Press
IUpload Ready for Press
View Signed Ready for Press

5. The signed version of the Ready for Press is opened in an external window

In order to send the signed Ready for Press:

1. Access the Volume of which you want to send the Ready for Press

2. Click on the PPF |m button
3. The Print Production File form is displayed
4. Select Ready for Press 2 Send Signed Ready for Press from the menu.

Ready for Press
Edit Ready for Press
View Ready for Press
Upload Ready for Press
View Signed Ready for Press
Send Signed Ready for Press

5. A confirmation message is displayed in order to proceed or cancel the action. Click the OK button to
proceed with the sending of the signed Ready for Press.

Note: The Ready for Press as well as the acknowledge message from the Printer will be saved in the
Correspondence folder of the Volume. Upon receiving the acknowledge message from the printer, the “Ready for
Press” State changes to “Complete”. The corresponding audit event is saved in the Audit trail.

4.22 Send Forecast to Ceres
In order to prepare and send a forecast to CERES:
1. Access the Volume for which you want to send the forecast to CERES

2. Select Edit = Edit Ceres form from the menu (the option is also available under the Volume Functions

menu of the PPF)
Edit View Tools Administrat
Edit Volume Metadata
Edit Ceres form
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3. The Ceres Form is displayed

Ceres Form

Volume-01-001-HR 22/07/11  Printer: 10288/Euroscript

Language: HR

Paper -
Vermn:|1ﬂ-m-zﬂ11 &8s - |09 v |00 v
Electronic
vermn:h:r';-m-zﬂﬂ |&8d- |15 v|[o0 v| Ormx Cleor

Comments:

* Mandatory fields

Figure 86: Ceres Form

Fill in all the necessary information
Click the Save button in order to save the Ceres Form

Click the Send to Ceres button

N o ke

The form is stored and send to Ceres

4.23 Close a Volume
In order to close a Volume:

1. Access the Volume that you want to close

2. Click on the PPF |m button
3. The Print Production File form is displayed
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4. Select Volume Functions = Close Volume from the menu.

Volume Functions Document Functions

Edit Volume metadata
Export Letter for Legal Services

Send Budget Reguest to DEMED
Send Publication reguest to Printer
Upload files

Cloze Volume

Edit Ceres form
Audit Volume

5. A confirmation message is displayed

Close Volume

@ Are you sure you want to close volume 7

Figure 87: Close Volume Confirmation message

6. Click the Close Volume button in order to confirm the action
7. The PPF will be displayed again
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Note: The zip file containing the PPF and the “Ready for Press” as well as the acknowledge message from the
Printer will be saved under the Correspondence folder.

4.24 Open a Closed Volume
In order to open a closed Volume:

1. Access the Volume that you want to open

2. Click on the PPF |m button
The Print Production File form is displayed

4. Select Volume Functions = Open Volume from the menu.

Volume Functions Document Functions

Edit Volurme metadata
Export Letter for Legal Services

Send Budget Request to DEMED
Send Publication request to Printer
Upload files

COpen Yolume
Edit Ceres form
Audit Volume

5. A confirmation message is displayed
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Open Volume

@ Are you sure you want to open volume ?

Figure 88: Open Volume Confirmation message

6. Click the Open Volume button in order to confirm the action

7. The PPF will be displayed again

4.25 Characterisation

In order to perform a characterisation of a Volume:
1. Locate the corresponding task in your Inbox
2. Double click on the task to open it
3. The Characterisation task is displayed
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Characterisation for Volume-13-003-15

Description Please, execute characterisation to the Yolume

Volume name Volume-13-003-15

Chapter 13 Industrial policy and internal market

Language I5

Assignee Tina PA {ED}

Catalogue Name

Publication Date 10/07/2011
Printer 10288: Euroscript
Total pages 3

Comments comments

Hame Version Size Date Hodified

Figure 89: Characterisation Task

4. Click the Accept button in order to accept the task. This action will remove the task from other PAs’ and
GCs Inboxes

5. Click the PPF button |m or select the option View = View PPF from the main menu
6. The PPF form is displayed
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Print Production File :
Volume Functions Document Functions Ready for Press

Volume-01-002-HR  Mov 14, 2011 10288/Euroscript Total Pages: 2 Status: Prepare Demed Status: DATA_CHANGE Language

TOC Pages: Document Titles: @ show O Hide

D Document Publication

\dentifier Reference Status Included/Excluded — _e Length Comments

Decision creating the "Official Journal of the European Communities’

. T an Prior- ~
O @ z1ssa01008001) 1958P017p0390 Rescing Included 1 h ]

63/32/EEC: Council Decisien of 18 December 1962 on the determination of the appeinting authority for the Audit Board

[0 @ 3198300032 1963P012p0139 et Included 2 2 1 ||

Available

Figure 90: Print Production File

7. Fill in the Printed Pages and TOC Pages fields.

8. Ifneeded you can also modify the Publication Date from the Edit Volume Metadata form which can be
accessed from the menu Volume Functions = Edit Volume Metadata.

9. Click the Save button from the PPF form in order to save the modifications.
10. Select the menu option Volume Functions - Send Publication Confirmation to DEMED.

Volume Functions Document Functions Ready for Press
Edit Volume metadata
Export Letter for Legal Services

Total P

Send Publication Confirmation to DEMED
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11. A confirmation message for sending the Publication Confirmation to DEMED is displayed

Send information to DEMED

@ Are you sure you want to send the information to DEMED 7

Figure 91: Send Publication Confirmation to DEMED Confirmation

12. Click the Send to DEMED button to confirm the action and return to the PPF.
13. Click on Cancel button to return to the task.
14. Click the Finish button in order to finish the task.

4.26 Change the Status of a Volume
In order to change the status of a Volume:
1. Access the Volume of which you want to change the status

2. Select Edit > Edit Volume Metadata from the menu. (You can also access the Metadata form from by
selecting Volume Functions 2 Edit Volume Metadata from the PPF menu)
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Edit View Tools Administrat;

Edit Volume Metadata

Edit Ceres form

3. The Edit Volume Metadata form is displayed

Edit Yolume Metadata :

Chapter : 20 People’s Europe

Language : HR

Volume Number: 001
Catalogue Number: py.az- EI -HR-C

Yolume Year: |2EI11

Publication Date : |1}4-Aug-2ﬁ1 1

Printer : | 10288/Euroscript

Total Pages: 12

TOC Pages: |3

Yolume Status : | Published

Assignee : | Tina PA (ED)

DEMED Reference : 9340
DEMED Status : PUBLISHED
DEMED Progress : COMPLETE
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Figure 92: Edit Volume Metadata Form

4. Change the new status from the Volume Status drop down list

5. Click the Save button in order to save the modifications and return to the PPF form

4.27 Assign, Reassign and Cancel Task

In order to assign a Task:

1. Select File > Assign Task

Administration

Help Shift+H
About Plan-DD

Manual Upload/Update of Document LY

Assign Task

2. The Assignment of Reading tasks form is displayed.

Mew 4

Issue Date:

09/12/2011

Document File Name:

D.PDD.UMA-2.2.0 - User Manual v0.05.doc

Page:
109 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

Assignment of Reading tasks

Language [ —
Tosk I TSN o £

Chapter E T Dociment entter |+ | %]

Search

i (%) (4] Page - I x Iof 1 Items per page

INFORMATION: Please select Tasks before performing one of the available actions: Assign, Re-assign or Abort. The action will take effect only on
currently displayed page.

Document Yolume Task

2 . Task type Proofreader [ue date Priority  Comments
identifier name status
Document J0-Mow-2011
22002D0161-HR _ _ darmant " Medium
D Priof-reading arman E,
Abort task Save Cancel

Figure 93: Assignment of Reading Tasks Form

3. Use the available search criteria and press the “Search” button to find tasks. You can also navigate through
the pages by using the “Next” and “Previous” page buttons or by entering a page number into the
appropriate field and hit the “Enter” of your keyboard.

4. Select the tasks that you want to assign to a specific Proofreader by selecting the corresponding check
boxes.

5. Select the “Proofreader” and the “Priority” by using the drop down lists and the “Due Date” by using the
corresponding calendar button.

6. Click the Save button in order confirm the assignment. An email notification will be sent to the previous
selected Proofreaders.

Note: By following the above steps you can also reassign a task to a different Proofreader.

In order to cancel a Task:

1. Select File > Assign Task
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Edit View Tools Administration

Mew 3

Help Shift+H
About Plan-DD

Manual Upload/Update of Document LY

Assign Task

2. The Assignment of Reading tasks form is displayed

Assignment of Reading tasks

Language [ Proofreader ]
Tasi TR omerane [ 2]

e, — Dosumet aerter | & |

Search

O (&) (&) Page - I X IDf 1 Items per page

INFORMATION: Please select Tasks before performing one of the available actions: Assign, Re-assign or Abort. The action will take effect only on
currently displayed page.

Document Volume Task
. . Task type Proofreader [ue date Priority  Comments
identifier name status

Document 30-Maw-2011
D Prior-reading orman [ﬂ] sl

Abort task Save Cancel

Figure 94: Assignment of Reading Tasks Form
3. Use the available search criteria and press the “Search” button to find tasks.

4. Select the tasks that you want to cancel by selecting the corresponding check boxes

5. Click the Abort button in order to abort the task.
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Confirm Document Abort Action

i‘: The selected tasks wil be aborted and the status of the Document LVs will be promoted to the next available. Confirm the abort of

the tasks.

Figure 95: Abort a Reading Task— Confirmation page

6. Confirm the cancellation. The cancelled tasks will be removed from the Proofreaders’ inbox and the status
is forwarded to the next applicable.

4.28 Create/Update Ready for Press Template
In order to create or update the Ready for Press Template:

1. Select File > Update Ready for Press Template
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File Edit View Tools Administration

Mew

Help
About Plan-DD

Manual Upload /Update of Document LY
Aszsign Task

|Update Ready for Press Template

Logout

2. The Ready for Press template is displayed

Ready for Press Template

Description

Archive

.
. 2]
@

Affichage réception

I

Infotechnigus

I

Stock

I

Menge fiir Direktversand: lose (auf Paletten oder in Containern) an das Amt fiir Verdffentlichungen
(Gasperich} zu liefern/Exemplaires pour diffusion a livrer (sur palettes ou dans des contensurs) a
['Office des publications (Gasperich)

"]

<>

Commande spéciale

I

Total

Figure 96: Ready for Press template

3. Fill in or update the available fields

Shift+H

Shift+0

AU EX HR 15 MU

) [ ]
BB
T EIE ]

oujcaioei
I E b
o) e b b

E removeling add line

=
=

52 A0 i1}

Issue Date:

09/12/2011

Document File Name:

D.PDD.UMA-2.2.0 - User Manual v0.05.doc

Page:
113 of 142




PLAN-DD USER MANUAL

Project / Subproject:
PLAN-JO No. 10238

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

4. Click the Save button in order to save the template with the last modifications
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5 Proofreader

5.1 Proofreaders' Inbox

Logged in as proofreader (hr), proofreader (is) | Logout  Help

EE -

Edit Wiew Tools

Add Repositary Inbox (plandd_prod) | am availabie Show Al (Hide Attachments) v
m Pagennf 1+ Items per page:

i Subject | From | Date Received | Due Date| Status | Repository
. H Document Prior-reading for 32009R0304-15 dmadmin 14/05/2011 10:44 Dormant plandd_prod /:
. El Document Prior-reading for 32009R0279-15 dmadmin 14/05/2011 10:44 Dormant plandd_prod
H H Document Prior-reading for 32009R0308-15 dmadmin 14/05/2011 10:44 Dormant plandd_prod
: H Document Prior-reading for 32009R0107-15 dmadmin  14/05/2011 09:47 Dormant plandd_prod A
H H Document Prior-reading for 324 )-15 dmadmin 14/05/2011 09:47 Dormant plandd_prod
4 El Document Prior-reading for 32009R0069-15 dmadmin 14/05/2011 09:47 Dormant plandd_prod
H H Document Prior-reading for 32009R0068-15 dmadmin 14/05/2011 09:45 Dormant plandd_prod
- H Document Prior-reading for 324 0053-15 dmadmin 14/05/2011 09:45 Dormant plandd_prod
H kl Document Prior-reading for 32009L0009-15 dmadmin 14/05/2011 08:46 Dermant plandd_prod
- H Document Prior-reading for 32009L0006-15 dmadmin 14/05/2011 08:46 Dormant plandd_prod
. H Document Prior-reading for 3200900:083-15 dmadmin 14/05/2011 08:46 Dormant plandd_prod
! El Document Prior-reading for 32009L0004-15 dmadmin 14/05/2011 08:46 Dormant plandd_prod
H H Document Prior-reading for 324 }05-15 dmadmin 14/05/2011 08:46 Dormant plandd_prod
: H Document Prior-reading for 32008R1272-15 dmadmin 14/068/2011 07:49 Dormant plandd_prod
H H Document Prior-reading for 32008R1243-15 dmadmin 14/05/2011 07:45 Dormant plandd_prod
4 El Document Prior-reading for 32008R1107-15 dmadmin 14/05/2011 07:45 Dormant plandd_prod
H H Document Prior-reading for 32008R1057-15 dmadmin 14/05/2011 07:45 Dormant plandd_prod
: El Document Prior-readine for 32008R1234-15 dmadmin 14/05/2011 07:45 Dormant olandd orod ¥

Figure 97: Proofreaders' Inbox

5.2 Document LV Prior-Reading

The Prior-Reading task is part of the Prior-reading workflow. When a Document LV is uploaded a (Prior-Reading
or Control-Reading) workflow starts. As a result the Prior-reading state starts and the Status of the document
changes to Prior-Reading. The Prior-Reading task will be sent to the inbox only when PLAN-DD system receives a
response from OJ-Format or after 24 hours. In case a user executes a manual upload/update of a Document LV and
the OJ-Format is selected to be excluded, the task will automatically come to the inbox.

In order to perform a Document Prior-Reading task:
1. Locate the corresponding task in your Inbox
2. Double click on the task to open it
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Document Prior-reading for 32009R0279-I15
Description: Please, execute prior-reading to the Document LV
Document Reference 32009R0279
Language: 15
Chapter: 05 05.20.20.10 Safety at work
Publication Reference:
Publication Date:
Humber of pages: (1}
Volume name:
CCVista Status:
Title EN:
Comments:
Hame Version Size Date Modified
@ 20:09R0Z79-15.doc 1.0,CURRENT,Original 25088 1370672011 10:44

[ Accept || Finian [| Reject | Close|

Figure 98: Prior-Reading Task

3. Click the Accept button in order to accept the task. This action will remove the task from other
Proofreaders’ Inboxes

4. Open the details of the Document by clicking on the Metadata button. At this stage you can edit the
Official Title and the Comments of the Document

5. Click the OK button to save any modifications and return to the Task

6. Select the document from the list in the Task and then select File > Check Out from the menu or from the
right click menu.

File Echt View Tools
Mew »

Edit E
Open (Read Only)

Check Out Q
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7. Select the Checked Out document from the list in the Task and then select File > Edit from the menu or
from the right click menu. You can also directly perform this step without having first check out the file as
it will be automatically checked out when selecting to edit it.

File Edit WView Tools
Mew k

Edit E
Open (Read Only) W

Check In I

Cancel Checkout

8. Modify the document, click the save button of the MS Word application and close the document

9. Select the document from the list in the Task and then select File @ Check In from the menu or from the
right click menu.

File Edit View Tools
Mew r

Edit E
Open (Read Only) V

Ched: In T

Cancel Checkout

10. The Check In page is displayed where you can select to replace the checked out document or to upload it as
a new version. By default a new version is proposed by the system
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Checkin : 32009R0279-15.doc

@ | J2009R0279-15.doc

Version = 1.0, CURRENT, Original
Type: pdd_celex_content
Format: msw

'O' 1.0 (same version)
Save as : & 1.1 (minor version)

{::' 2.0 (major version)

Version label: |

Description: |

Format: | M5 Word 4., 5.2 (DO5)

Lifecycle ID:  Select

Current State:

|:| Check for links to other Microsoft documents and checlk in linked
documents

Document Links:

|:| Retain Lock
Make this the current version
|:| Keep a local copy after check in

[ subscribe to this file

] check in from file

Figure 99: Check In Corrected Version

11. After defining the version of the uploaded document, click the OK button to confirm the action. In case
you want to replace the existing document with a completely new one, you can use the Browse button and
locate the document that you want to upload.
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12. If you have not browse to another page of the application, after uploading the modified file, you will be
directed to the Prior-Reading task. Otherwise, browse to your Inbox and double click to open the same
Task.

13. Click the Finish button to finalise the Prior-Reading task or the Reject button to reject the document. The
task will be also removed from you Inbox. In case, a task is rejected, a form appears to enter a justification
reason (a task might be rejected only for the reason of having bad quality) and an e-mail notification is sent
to PA and GC. The status of the document remains at prior-reading. After that, PA/GC can start a new
prior-reading workflow by uploading the correct version of the document.

Note: In case an attached document is checked out and you try to finish the task, a message will be displayed

informing you that some of the task attachments are checked out.
Note: A Task can be finished by using the “Finish” button which is accessible only through the task page.

5.3 Document LV Control-Reading

The Control-Reading task is part of the Control-reading workflow. When a Document LV is uploaded a (Prior-
Reading or Control-Reading) workflow starts. As a result the Control-Reading state starts and the Status of the
document changes to Control-Reading. The Control-Reading task will be sent to the inbox only when PLAN-DD
system receives a response from OJ-Format or after 24 hours. In case a user executes a manual upload/update of a

Document LV and the OJ-Format is selected to be excluded, the task will automatically come to the inbox.

In order to perform a Document Control-Reading task:

1. Locate the corresponding task in your Inbox

2. Double click on the task to open it
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Mztadata

Document Manager

Control-reading for document 31988L0667-HR

Description

Please, execute control-reading to the Document LY

Document Reference  31988L0667

Language

Chapter

HR

13 Industrial policy and internal market

Publication Reference 1988L382p0046

Publication Date

Humber of pages 3

Volume name

CCVista Status Finalised

Title EM

Comments

Council Directive 88/667/EEC of 21 December 1988 amending for the
fourth time Directive 76/768/EEC on the approximation of ...

s Prior-reading has not been performed

h

Attachments
Name Version Size
31938L0667T-HR.doc 1.0,CURRENT, Finalised 52 KB

Figure 100: Control-Reading Task

Date Modified

01,/07/2011 12:08

3. Click the Accept button in order to accept the task. This action will remove the task from other
Proofreaders’ Inboxes

4. Open the details of the Document by clicking on the Metadata button. At this stage you can edit the
Official Title and the Comments of the Document

5. Click the OK button to save any modifications and return to the Task

6. Select the document from the list in the Task and then select File & Check Out from the menu or from the
right click menu.
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File Edit View Tools
Mew 3

Edit E
Open (Read Only) W

Check Out Q

7. Select the Checked Out document from the list in the Task and then select File > Edit from the menu or
from the right click menu. You can also directly perform this step without having first check out the file as
it will be automatically checked out when selecting to edit it.

File Edit Wiew [
Mew 4

Edit E
Cpen (Read Only) W

Chedk In I

Cancel Checkout

8. Modify the document, click the save button of the MS Word application and close the document

9. Select the document from the list in the Task and then select File 2 Check In from the menu or from the
right click menu.

File Edit View Tools
Mew 3

Edit E
Cpen (Read Only) ]

Ched: In T

Cancel Checkout

10. The Check In page is displayed where you can select to replace the checked out document or to upload it as
a new version. By default a new version is proposed by the system
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Checkin : 32009R0279-15.doc

@ | J2009R0279-15.doc

Version = 1.0, CURRENT, Original
Type: pdd_celex_content
Format: msw

'O' 1.0 (same version)
Save as : & 1.1 (minor version)

{::' 2.0 (major version)

Version label: |

Description: |

Format: | M5 Word 4., 5.2 (DO5)

Lifecycle ID:  Select
Current State:

|:| Check for links to other Microsoft documents and checlk in linked
documents

Document Links:

|:| Retain Lock

.l'-'.ake this the current version
|:| Keep a local copy after check in
[ subscribe to this fie

] check in from file

Figure 101: Check In Corrected Version

11. After defining the version of the uploaded document, click the OK button to confirm the action. In case
you want to replace the existing document with a completely new one, you can use the Browse button and
locate the document that you want to upload.

12. If you have not browse to another page of the application, after uploading the modified file, you will be
directed to the Control-Reading task. Otherwise, browse to your Inbox and double click to open the same
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Task. Click the Finish button to finalise the Prior-Reading action. The task will be also removed from you
Inbox.

Note: In case an attached document is checked out and you try to finish the task, a message will be displayed

informing you that some of the task attachments are checked out.
Note: A Task can be finished by using the “Finish” button which is accessible only through the task page.

5.4 Send files to OJ-Format

When an active task has been accepted by a Proofreader (Document LV states "In progress" for either Prior-reading

or Control-reading) then the menu option to send files to OJ-Format becomes available.

In order to send files to OJ-Format:

1. Select Edit = Send to OJ-Format (this menu option is available from both the Document L'V Manager

and within the accepted Task)

Edit View Tools
Edit Document LY Metadata

Update Metadata From Procat
Send to OJ-Format

2. The Send Files to OJ-Format form is displayed
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Send Files to OJ-Format :

Select the version of the Document files that will be sent to OJ-Format.

File Hame File Versions

0] 32001L0017-HR.doc | 3.0,CURRENT,Cleansd % | View

Figure 102: Send Files to OJ-Format

3. Select the version that you want to send to OJ-Format by using the File Versions drop down list
4. Click the OK button in order to send all the files under Document L'V to OJ-Format
In case that a document is checked out, the following blocking message will be displayed:

"The following files are checked out: 32001D0528-HR.doc, Proof Reader (ED), 20/10/2011 12:55:47. Please,
check in before sending the files to OJ-Format”.

Moreover, the system will raise an error and it will not update the documents with their cleaned versions. The zip
from OJ-Format will be moved to failed folder and an e-mail notification will be sent to the responsible person who
triggered the functionality.

All sent documents will be versioned by increasing the major number and adding the "Cleaned" version label and
the OJ-Format cleaned file response will be discarded if it is received after the task has been finished (no active
reading workflow task exists). Proofreader can finish the task even though an OJ-Format request is in progress.

The document audit will be updated with the new request and the result of OJ-Format.
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5.5 Volume Proofreading

In order to perform proofreading of a Volume proof received from a Printer:

1. Locate the corresponding task in your Inbox

2. Double click on the task to open it

Volume Name Volume-01-007-HR

Chapter 01 General, financial and instituticnal matters
Language HR
Assignee General Coordinator (ED)

Catalogue Mumber FX-AZ-13-060-HR-C

Publication date 20-Oct-2011

Contract Supplier 10288/ Euroscript

Total pages 3
DEMED Status MOT_CREATED
DEMED Progress UMIMITIALISED
Created Prepare Legal Yalidation Legally Yalidated

Full Content_size Format

Hame Version Maodifier Modified

Ll Proofs CURRENT,1.0 General Coordinator (ED) 20/10/2011 15:30 1 KB

Crolered

Started Inprogress Completed
Legal Services
Budget Request
Publication Request
Proof-reading
CERES
Ready for Press
Close Volume
Characterisation
Publication Confirmation
SICOF

State Legend : @ Valid © Disabled ® Invalid

Cloged Published

Proof-Reading

Ready for Publication Characterized

| 2

Figure 103: Volume Proofreading Task

3. Click the Accept button in order to accept the task. This action will remove the

Proofreaders’ Inboxes

4. You can open to view the Metadata and the content of the Proof.

task from other

5. Click the Finish button to finalise the Proof-Reading action or the Reject button to reject the volume. The
task will be also removed from you Inbox.

Note 1: A Task can be finished by using the “Finish” button which is accessible only through the task page.

Note 2: All proofs received from the Printer will be saved under the Correspondence folder. The system sends an
Email notification to the Production Agents and General Coordinator group informing that a Volume Proofreading
task has been finished. The status of the volume changes to “Ready for Publication” and the state changes to

“Completed”.

5.5.1

View the Model

In order to view a Model:
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1. Browse you Inbox and double click on a Task to open it

2. Select View > View Model from the menu on the Web top.

View Tools
View Model
Versions
Relationships
Renditions

Locations

3. The Document Manager is displayed and the Models folder is visible in the list

File Edit

View Tools

Document 319821L.0890-15

Metadata Audit Document

Document Identifier

Language

Chapter

3198210890

15

13 13.30.14 Foodstuffs

Publication Reference

Publication date
Humber of pages
Vaolume Name
CC Vista Status

Title EN

Mat &vailable

Hame

LU Models

@ 31982L0890-15.doc 33 KB

1]

Pricr-Reading Legal Finalization

Full Content_size Modified Farmat

1KB ZFA0642011 18:14

Caontrol-Reading

Started In progress Completed
Procat @
0J-Format L
Prior-reading ]

Control-reading
Property Cleaning
EUR-Lex

Cellar

State Legend : @ valid @ Disabled ® Invalid

Resdy for Printer Published

Lifecvcle State

14/04/ 2011 17:35 M5 Word 4.x, ...

Figure 104: View Model
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6 Dashboards

Dashboards are forms which can be used in order to generate reports containing documents, volumes, tasks or for
order tracking purposes according to selected criteria. Dashboards are available under Dashboards label on the left
navigation tree.

In order to open a dashboard, click on the Dashboards of the left navigation tree and then select one of the
available dashboards: Documents, Task Workload, Volumes or Order Tracking.

6.1.1 Documents
In order to get a list of documents by using the Documents Dashboard:
1. Click on Documents option under the Dashboards of the left navigation tree

2. The Documents Dashboard form is displayed.

Documents Dashboard

Enlargement Enlargement 2015 A

Volume name m
Document identifier m

Chapter
Language View State @ Included @ Excluded © All

[
[

Document statuses

Control-Reading
Legal Finalisation
Mot Available
Pricr-Reading

Selected statuses Document states

Control-reading
EUR-Lex
0J-Format

Selected states

™
Kl

Proofreaders Selected proofreaders CCvista status Selected CCvista status

™
[
Scarch | [(Eport fo excel | Weset Search |

Export to Excel || Reset Search

Finalised
Mot revised
Mot Translated

€0 €0 Page I of 112: D D

Items Per Page

Document Humber of Document CCvista status ~ State Publication Proofreader Prior-reading Modelloaded Deadline Word author file loaded
identifier pages statuses Reference
3200200585-TR 4 Mot Available Mot Translated  Included 2002L187p0044 No No Mo
3 Mot Available Mot Translated  Included 20020L123p0050 Mo Mo Mo
z Mot Available Mot revised Included 2001L327) No No Mo
7 Mot Available Mot Translated  Included 200301099 Mo Mo Mo
AWANIMNCOE TR 7 Rlms Auemilable blms Teamelabmd Pl AN ANOANNA D Rl Rl Rl [

Figure 105: Documents Dashboards

3. Select the criteria that you want by using the corresponding free text fields and drop down lists or multi-
select boxes. Every time you select or modify search criteria, the Search button should be clicked in order
to get the results.

4. You can select specific Document Proofreaders by selecting specific users from the Proofreaders list and
use the Add “ button in order to add them in the Selected Proofreaders list. Similarly you can remover

Proofreaders by using the Remove |n button. In the same way you can select specific “Document
statuses”, “Document states” or “CCvista status” from the corresponding lists.

5. Click on the Search button in order to perform the search based on the selected criteria.
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Each time the Search button is used, the user’s Dashboard selections will be saved. The selections and results will
be saved for the specific session and when the user logs out or closes the browser the values will be lost.

In the results list of Documents, the following columns are available depending on the selected View:
Documents View:
e Document Identifier
e Number of Pages
e Document statuses
e (CCVista Status
e State
e Publication Reference
e Proofreader
e Prior-Reading
e Model loaded
e Deadline

e  Word Author File Loaded

Volumes View:
e Language

e Chapter

e Volume

e Number of Documents

When selecting the document view, the Document Identifier of each document is a link that by clicking on it will
direct you to the Document Manager of the document. Document Manager is also accessible from the right click
menu Document Manager. In order to go back to the Document Dashboard, select the option Documents under
Dashboards from the left navigation tree.

Document Humber of Production CCwvista status  State
identifier pages status

J2004R2076-
T EEE— Document Manager
Ky 3 Included

When selecting the volume view, the Volume Identifier of each volume is a link that by clicking on it will direct
you to the Volume Manager of the document. Volume Manager is also accessible from the right click menu
Volume Manager

After the generation of a dashboard, the following buttons are enabled:

Issue Date: Document File Name: Page:

09/12/2011 D.PDD.UMA-2.2.0 - User Manual v0.05.doc 128 of 142




Project / Subproject:
PLAN-JO No. 10238

PLAN-DD USER MANUAL

Reference Number / Version:

D.PDD.UMA-2.2.0/0.05

Export to Excel || Rezet Search

Search: Click to perform a search with the already defined criteria
Export to Excel: Click to export the search results in Excel format

Reset Search: Click to re-initialise the Dashboard and reset all previously selected criteria and results

6.1.2 Volumes
In order to get a list of volumes by using the Volumes Dashboard:
1. Click on Volumes option under the Dashboards of the left navigation tree

2. The Volumes Dashboard form is displayed.

Volumes Dashboard

[ ET0 =g Enlargement 2013 | W BTN 01 General, financial and institutional matters

Volume status Selected statuses

Language m Closed 3 lII

Created E

Legally Validated
Export to Excel | Reset Search

Items Per Page

Chapter Volume Language Yolume Publication Catalogue Humber of Pages Humber Of Pages Of Percentage Percentage Assignee Volume Owner P

Hame Hame status Date Humber documents Ready Ready of Ready  of pages of
Documents Documents Documents ready

documents
01 General,
financial
and Volume- General
institutional 01-001- Ready for FX-AZ-13- Coordinator
matters HR HR Publication 17/11/2011 001-HR-C 2 4 2 4 100.0 100.0 (ED) 1
01 General,
financial
and Volune- General L8
institutional 01-003- FX-AZ-13- Coardinator
matters HR HR Prepare 1771142011 007-HR-C 2 z 0 0 0.0 0.0 (ED) 1
01 General,
financial w

Figure 106: Volumes Dashboards

3. Select the criteria that you want by using the corresponding free text fields, multi-select boxes and drop
down lists. Every time you select or modify search criteria, the Search button should be clicked in order to
get the results.

4. Click on the Search button in order to perform the search based on the selected criteria.

Each time the Search button is used, the user’s Dashboard selections will be saved. The selections and results will
be saved for the specific session and when the user logs out or closes the browser the values will be lost.

In the results list of Documents, the following columns are available:

e Chapter Name
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Volume Name

Language

Volume Status

Publication Date

Catalogue Number

Number of Documents

Pages

Number of Ready Documents
Pages of Ready Documents
Percentage of Ready Documents

Percentage of pages of ready documents (the number of pages of ready documents of the volume
divided by the total number of pages of the volume)

Assignee
Volume Owner

Printer

The Volume Name of each volume is a link that by clicking on it will direct you to the Volume Manager of the
document. Volume Manager is also accessible from the right click menu Volume Manager. Right click menu has
also the options to edit the Volume Metadata by selecting the Edit Volume Metadata option or view the PPF by
selecting the View PPF option. In order to go back to the Volumes Dashboard, select the option Volumes under
Dashboards from the left navigation tree.

Chapter Yolume Language Volume Publication Catalogue Humber of Pages
Hame Hame status  Date Humber documents

01 General,

financial and Yolume Manager

institutional Vol -01- :

[etitutions: - JodmeL - Edit Volume Metadata

tt 00B-HR HR 0
e e View PPF

After the generation of a dashboard, the following buttons are enabled:

Search
Search: Click to perform a search with the already defined criteria
Export to Excel: Click to export the search results in Excel format

Reset Search: Click to re-initialise the Dashboard and reset all previously selected criteria and results
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6.1.3 Task Workload

In order to get a list and information of Tasks assigned to specific Proofreader(s) of documents by using the Task

Workload:

1. Click on Tasks Workload option under the Dashboards of the left navigation tree
2. The Tasks Workload form is displayed.

Task Workload

ertrgomen: XTI orsus- BN Prosiader

Panos Kavalagios (ED)
Froof Reader (ED)

Proof Reader HR (ED)
: - i Ml W
Chapter Assigned “root Remsr 15 £D)

View

From .

Control-reading
Pricr-reading

1 Proof-readin
Voume nane 131 o :

Document identifier m
Reset Search

Froofreader

Panos Kavalagios (ED)

Proof Reader (ED)

Froduction Status Number of tasks
Control-Reading 4

Pricr-Reading 2429
Control-Reading 169
Control-Reading 1

Figure 107: Task Workload

Selected Proofreaders

:

Selected Task Type

Show items

Number of pages
16

30325
5972
2

3. Select the criteria that you want by using the corresponding free text fields, multi-select boxes and drop
down lists. Every time you select or modify search criteria, the Search button should be clicked in order to
get the results.

4. Click on the Search button in order to perform the search based on the selected criteria.

Each time the Search button is used, the user’s Dashboard selections will be saved. The selections and results will
be saved for the specific session and when the user logs out or closes the browser the values will be lost.

In the results list, the following columns are available depending on the selected View:

User View:

Proofreader

Production Status
Number of Tasks
Number of Pages

The option View list of documents per user is available in the right click menu of each entry of the results list.

Proof Reader HR (ED) | View list of documents per user

Proof Reader 15 (ED) Prior-Reading
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The displayed list contains all the documents that a task has been assigned to the specific Proofreader.
Status View:
e Production Status
e Number of Tasks
e Number of Pages

The option View list of documents per user is available in the right click menu of each entry of the results list.

Proof Reader HR (EDY | View list of documents per user

Proof Reader |5 (ED) Prior-Reading

The displayed list contains all the documents that a task has been assigned to the specific Proofreader

Task View:

e Document Identifier

e Chapter

e Volume Name

e Production Status

e Prior-Reading

e Proofreader

e Assigned

e Number of Pages

e Days spent on task

The option Document Manager is available in the right click menu from where you can directly access the
document manager form of the selected document. In order to go back to the Task Workload, click the select the
option Task Workload under Dashboards from the left navigation tree.

The option Assign documents to proofreaders is available in the right click menu of each entry of the results list.
In order to close the Assignment of Reading tasks form and go back to the Task Workload, click on the Cancel

button.

Document Chapter Yolume name Production Prior-
Identifier status reading
01 Gene

Assign tasks bo Proofreaders
S1998RFEI-HR  institutid bocment Manager Prior-Reading Mo

The Assignment of Reading Tasks form is displayed from where the user can assign the specific Task.
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O

Document
identifier

Assign Task: In order to assign the task to a specific Proof-Reader, select the Proof-Reader from the corresponding
button to save the changes. You can also define the Due Date and
the Priority of the assigned Task by using the corresponding fields or add Comments if needed. After you have
assigned a task successfully the message “Task successfully assigned/re-assigned” will be displayed next to the

drop down list and then click the Save

Chapter

[] zz00200181-HR:

Assignment of Reading tasks

o proofreader [
Tk EIRETINE T Y £

@@Page- leof1®

currently displayed page.

Yolume Task

Task type Proofreader [ue date
name status

Daocument J0-Mow-2011

Prior-reading @,

Abort task

Daocument ldentifier . B

Search

Priority

Figure 108: Assignment of Reading Tasks

ltems per page

IMFORMATIOHN: Please select Tasks before performing one of the available actions: Assign, Re-assign or Abort. The action will take effect only on

Comments

Save Cancel

Comments field. An email notification also is sent to the Proof-Reader that the task has been assigned.

Abort Task: In order to abort a task, select the check box in front of the task and then click the Abort

button

After the generation of a dashboard, the following buttons are enabled:

Export to Excel || Rezet Search

Search: Click to perform a search with the already defined criteria

Export to Excel: Click to export the search results in Excel format

Reset Search: Click to re-initialise the Dashboard and reset all previously selected criteria and results
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6.1.4 Order Tracking: Orders sent to Printers

In order to get reports containing total number of pages sent to a Printer per Chapter and per Printer and having a

budget consumption tracking by using the Order Tracking Dashboard:
1. Click on Order Tracking option under the Dashboards of the left navigation tree
2. The Order Tracking form is displayed.

Order Tracking

printer N Date of order from N

Production status Selected Production statuses

]
Date of order to
[<]

Legally Validated

vaumenane 14 ]
Export to Excel || Reset Search

£ D Page of 2103 Items Per Page
Demed Volume name Production status  Date of Printer Humber of Total pages
reference Publication documents
request
852 Prepare 10288/ Eurascript 2 2
Prepare 10288/ Euroscript 1 3
1303 Prepare 10288/ Euroscript 1 6
Prepare 10288/ Euroscript 2 2
7325 Volume-10-001-HR Legally Validated 10288/ Eurascript 2 G
Ready for
3153 Volume-01-001-HR Publication 1871142011 10288/ Euroscript 2 4
Ready for
2770 Velume-13-002-HR Publication O8/11/2011 10288/Euroscript 1 2
10202/LOT 1/Eurescript 1]
10202/L0T 2/ Jouve ¢

Figure 109: Order Tracking

==

[=TR =T 4

3. Select the criteria that you want by using the corresponding drop down lists, multi-select boxes and
calendars. Every time you select or modify search criteria, the Search button should be clicked in order to

get the results.

4. Click on the Search button in order to perform the search based on the selected criteria.

Each time the Search button is used, the user’s Dashboard selections will be saved. The selections and results will
be saved for the specific session and when the user logs out or closes the browser the values will be lost.

In the results list of Documents, the following columns are available:
e DEMED reference
e Volume name
e Production status

e Date of Publication Request
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Printer

Number of Documents
Total Pages

Cost

After the generation of a dashboard, the following buttons are enabled:

Search || Export to Excel || Reset Search

Search: Click to perform a search with the already defined criteria

Export to Excel: Click to export the search results in Excel format

Reset Search: Click to re-initialise the Dashboard and reset all previously selected criteria and results
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7 Reports

Reports are forms which can be used in order to view statistics about documents, volumes, pages sent to Printers or

produced pages per task according to selected criteria. Reports are available under Reports label on the left
navigation tree.

In order to open a Report, click on the Reports of the left navigation tree and then select one of the available
reports: Documents, Volumes, Printing Statistics or Number of Produced Pages.

7.1 Documents Report

In order to get the statistics of Documents by selected Enlargement, Chapter, Production Status, Language,
Production State, Creation Date and State by using the Documents Report:

1. Click on Documents option under the Reports of the left navigation tree

2. The Documents Report form is displayed.

Documents Report

I ETg-r g Enlargsment 2012 R

Chapters Selected Chapters Document Status Selected Document Status

01 General, financial and institutional matter|les Control-Reading

02 Customs Union and free movement of gooc = Legal Finalisation El
03 Agriculture _ Mot Available

04 Fisheries Prior-Reading El
05 Freedom of movement for workers and soc Pukblished

06 Right of establishment and freedom to pro Ready for Printer

07 Transport policy b

Languages Selected Languages

15 lIl
K

Report Date Reiind / EEnd / XA State @ Included @ Excluded

Generate Report Export to Excel Reset Search

Ll R | R R ) Items per page:  RUIRE
Language Chapter Yolume name Document Status Total Acquis list status Humber of Percentage of Humber of pages Percentage of pages
pages documents documents

1 General, financial and institutional
HR. matters Volume-01-001-HR Prior-Reading 13 Included 1 100.0 5 83.33
HR 09 Taxation Volume-09-001-HR Not Available 25 Included 1 50.0 6 24.0
HR 09 Taxation Volume-09-001-HR Ready for Printer 25 Included 1 50.0 2 8.0
15 20 People’s Europe Volume-20-001-15 Mot Available 2 Included 1 100.0 B 250.0

01 General, financial and institutional
15 matters Volume-01-001-15 Mot Available 53 Included 547 97.48 5527 10418.87

Figure 110: Documents Report

3. Select the criteria that you want by using the corresponding drop down lists, combo boxes, radio buttons
and calendars. You can a value from a combo box, by selecting one or more values from the left list and
use the Add “ button in order to add them in the right list of the selected values. Similarly you can
remover values by using the Remove |n button.

4. To see the historical results of the report, fill in the Report Date.
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5. Click on the Generate Report button in order to generate the report based on the selected criteria.
In the results list of Documents, the following columns are available:
e Language
e Chapter
e Volume name
e Total Pages
e Document Status
e Acquis list status
e Number of documents
e Percentage of documents
e Number of pages

e Percentage of pages (The percentage is calculated on the number of attached document pages by
excluding the TOC pages)

After the generation of a report, the following buttons are enabled:

Generate Report Export to Excel | | Reset Search

Generate Report: Click to generate a new report based on new selected criteria
Export to Excel: Export the report results in Excel format

Reset Search: Reset all the search criteria

7.2 Volumes Report

In order to get the statistics of Volumes by selected Enlargement, Chapter, Production Status, Language, Printer,
Creation Date and view by using the Volumes Report:

1. Click on Volumes option under the Reports of the left navigation tree

2. The Volumes Report form is displayed.
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Volumes Report

(I ETt e Enlargement 2012 A

Chapters Selected Chapters Yolume Status Selected Volume Status

01 General, financial and institutional matterji)
02 Customs Unien and free movement of gooc E]
03 Agriculture

04 Fisheries

05 Freedom of movement for workers and sot
06 Right of establishment and freedom to pro
07 Transport policy i

]
Legally Validated E
Legal Validation
Ordered
Prepare

Languages Selected Languages Printers Selected Printers

10202 /LOT 1/Euroscript

lIl 10202/L0T 2/Euroscript lIl
10202/L0T 3/Euroscript

] 10202/LOT 4/ Diadeis [
10202/L0T 4/Euroscript
102027L0OT 4/ Jouve
10202/L0T 5/Euroscript

Icelandic

Report Date View
D v
Generate Report Export to Excel Reset Search
Items per page:
Language Chapter Number of volumes Attached documents Included documents Excluded documents Pages
01 General, financial and institutional
HR. matters 7 565 565 0 50
01 General, financial and institutional
15 matters 3 565 565 0 98
HR. 09 Taxation 1 z Z 0 25
HR 20 People’s Europe 1 2z 2 0 12
15 20 People’s Europe 1 z s ) 2

Figure 111: Volumes Report

3. Select the criteria that you want by using the corresponding drop down lists, combo boxes and calendars.

You can a value from a combo box, by selecting one or more values from the left list and use the Add n
button in order to add them in the right list of the selected values. Similarly you can remover values by

using the Remove |n button.
4. To see the historical results of the report, fill in the Report Date.
5. Click on the Generate Report button in order to generate the report based on the selected criteria.

In the results list of Documents, the following columns are available depending on the selected View.

Chapters View:
e Language
e Chapter

e Number of Volumes
e Attached Documents
e Included Documents
e Excluded Documents

e Pages
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Volumes View:
e Language
e Chapter
e Number of Volumes
e Attached Documents
e Included Documents
e Excluded Documents

e Pages

After the generation of a report, the following buttons are enabled:

Generate Report Export to Excel | | Reset Search

Generate Report: Click to generate a new report based on new selected criteria
Export to Excel: Export the report results in Excel format

Reset Search: Reset all the search criteria

7.3 Printing Statistics Report

In order to get the printing statistics of Documents, Volumes or pages sent to a Printer by selected Enlargement,
Language, Printer and Publication Date by using the Printing Statistics Report:

1. Click on Printing Statistics option under the Reports of the left navigation tree

2. The Printing Statistics Report form is displayed.
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Printing Statistics Report

(3| T = Enlargement 2012 %

Languages

Selected Languages

Printers

10202/L0T 1/Euroscript
10202/L0T 2/Euroscript
10202/LOT 3/Euroscript

Selected Printers

]
Kl

I5 III
v

10202/L0OT 4/Diadeis

Publication Date

From EE = 7o EE—
Generate Report Export to Excel Reset Search

Publication Date
1140742011 00:00
1240742011 09:20
13/07/2011 12:04
13/07/2011 14:23
1370742011 1451
15/07/2011 00:00
21/07/2011 11:1
22/0742011 00:00
27072011 1211
04/08/2011 00:00

Printer
10288/Euroscript
10288/ Euroscript
10288/ Euroscript
10288/Euroscript
10288/ Euroscript
10288/ Euroscript
10288/Euroscript
10288/ Euroscript
10288/ Euroscript
10288/Euroscript

Humber of Volumes

e . Y YT

Items Per Page

Humber of Documents
556

= = e OO RN = = e

Humber of Pages
53

Figure 112: Printing Statistics Report

3. Select the criteria that you want by using the corresponding drop down lists, combo boxes and calendars.

You can a value from a combo box, by selecting one or more values from the left list and use the Add “
button in order to add them in the right list of the selected values. Similarly you can remover values by

using the Remove |n button.
4. Click on the Generate Report button in order to generate the report based on the selected criteria.
In the results list of Documents, the following columns are available:

e Publication Date
e Printer
e Number of Volumes
e Number of Documents
e Number of Pages

After the generation of a report, the following buttons are enabled:

Generate Report Export to Excel Reszet Search

Generate Report: Click to generate a new report based on new selected criteria

Export to PDF: Export the report results in PDF format
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Export to Excel: Export the report results in Excel format

Reset Search: Reset all the search criteria

7.4  Number of Produced Pages Report

In order to get the number of produced pages by selected Enlargement, Language, Proofreaders, Task Types, Task
Activity Date and View by using the Number of Produced Pages Report:

1. Click on Number of Produced Pages Report option under the Reports of the left navigation tree
2. The Number of Produced Pages Report form is displayed.

Number of Produced Pages

[ ETger T Il Enlargement 2013 *
Language

Proofreaders Selected Proofreaders

Panos Kavalagios (ED)

Proof Reader (EDY)

Proof Reader HR (ED} III
Proof Reader 15 (ED) II|
Tina HR (ED)

Tina IS (ED)

Selected Task Types Task Activity Date
Control-reading From

To
Prior-reading III

Proof-reading
View by

© View by Task @ View by Ratio

Generate Report | | Expori to Excel | Reset Search

Figure 113: Number of Produced Pages Report

3. Select the criteria that you want by using the corresponding drop down lists, combo boxes, calendars and
view. You can select a value from a combo box, by selecting one or more values from the left list and use

the Add n button in order to add them in the right list of the selected values. Similarly you can remover
values by using the Remove |n button.

4. Click on the Generate Report button in order to generate the report based on the selected criteria.
In the results list of Documents, the following columns are available depending on the selected View.
View by Task:

Proofreader

Task Type

Number of Assigned Tasks
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e Assigned Pages

e Number of Read Tasks

e Read Pages

e Ratio Number of Pages per Day

View by Ratio:
e Proofreader

Ratio Number of Pages per Day

In case you want to select a specified time period of active tasks, this task activity is defined as following:

e A task was accepted in the specified time period

e A task was finished in the specified time period

e A task was pending in the specified time period

e Tasks that were finished before or tasks that have been accepted after the specified period will not be
included

The “Ratio number of pages per day” column is calculated as Read Pages / Number of Days and not as Read Pages
/ Assigned Pages / Number of Days

After the generation of a report, the following buttons are enabled:

Generate Report Export to Excel | | Reset Search

Generate Report: Click to generate a new report based on new selected criteria

Export to Excel: Export the report results in Excel format

Reset Search: Reset all the search criteria

Note: The Number of Produced Pages Report is available only for General Coordinator role.

END OF DOCUMENT
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